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Read this manual carefully before you use this machine and keep it handy for future reference. For safe and correct use, be sure to read the
Safety Information in "About This Machine" before using the machine.



Introduction

This manual contains detailed instructions and notes on the operation and use of this machine. For your
safety and benefit, read this manual carefully before using the machine. Keep this manual in a handy
place for quick reference.

Important

Contents of this manual are subject to change without prior notice. In no event will the company be li-
able for direct, indirect, special, incidental, or consequential damages as a result of handling or oper-
ating the machine.

Do not copy or print any item for which reproduction is prohibited by law.
Copying or printing the following items is generally prohibited by local law:
bank notes, revenue stamps, bonds, stock certificates, bank drafts, checks, passports, driver's licenses.

The preceding list is meant as a guide only and is not inclusive. We assume no responsibility for its
completeness or accuracy. If you have any questions concerning the legality of copying or printing cer-
tain items, consult with your legal advisor.

Caution:

Use of controls or adjustments or performance of procedures other than those specified in this manual
might result in hazardous radiation exposure.

Two kinds of size notation are employed in this manual. With this machine refer to the inch version.

Trademarks

Microsoft®, Windows® and Windows NT® are registered trademarks of Microsoft Corporation in the
United States and/or other countries.

Adobe®, PostScript®, Acrobat®, PageMaker® and Adobe Type Manager are registered trademarks of
Adobe Systems Incorporated.

PCL® is a registered trademark of Hewlett-Packard Company.

Apple, AppleTalk, EtherTalk, Macintosh, Mac OS and True Type are trademarks of Apple Computer,
Inc, registered in the U.S. and other countries.

Bonjour™ is a trademark of Apple Computer Inc.

IPS-PRINT™ Printer Language Emulation Copyright® 2000, Oak Technology, Inc., All Rights Re-
served.

UNIX is a registered trademark in the United States and other countries, licensed exclusively through
X/Open Company Limited.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc. and any use of such marks
by Ricoh Company, Ltd. is under license.

NetWare is a registered trademark of Novell, Inc.
UPnNP is a trademark of the UPnP Implementers Corporation.
PictBridge is a trademark.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

The proper names of the Windows operating systems are as follows:

* The product name of Windows® 95 is Microsoft® Windows® 95

* The product name of Windows® 98 is Microsoft® Windows® 98

e The product name of Windows® Me is Microsoft® Windows® Millennium Edition (Windows Me)

* The product name of Windows® 2000 are as follows:
Microsoft® Windows® 2000 Professional
Microsoft® Windows® 2000 Server
Microsoft® Windows® 2000 Advanced Server

» The product name of Windows® XP are as follows:
Microsoft® Windows® XP Home Edition
Microsoft® Windows® XP Professional

» The product names of Windows Server™ 2003 are as follows:
Microsoft® Windows Server™ 2003 Standard Edition
Microsoft® Windows Server™ 2003 Enterprise Edition
Microsoft® Windows Server™ 2003 Web Edition

e The product name of Windows NT® 4.0 are as follows:
Microsoft® Windows NT® Workstation 4.0
Microsoft® Windows NT® Server 4.0

Notes
Some illustrations in this manual might be slightly different from the machine.
Certain options might not be available in some countries. For details, please contact your local dealer.



Manuails for This Machine

Refer to the manuals that are relevant to what you want to do with the machine.

< About This Machine
Be sure to read the Safety Information in this manual before using the ma-
chine.
This manual provides an introduction to the functions of the machine. It also
explains the control panel, preparation procedures for using the machine,
how to enter text, and how to install the CD-ROMSs provided.

R
**

General Settings Guide

Explains User Tools settings, and Address Book procedures such as register-
ing fax numbers, e-mail addresses, and user codes. Also refer to this manual
for explanations on how to connect the machine.

« Trouble Shooting
Provides a guide to solving common problems, and explains how to replace
paper, print cartridges, and other consumables.

R
**

Security Reference

This manual is for administrators of the machine. It explains security func-
tions that the administrators can use to protect data from being tampered, or
prevent the machine from unauthorized use.

Also refer to this manual for the procedures for registering administrators, as
well as setting user and administrator authentication.

< Copy Reference
Explains Copier functions and operations. Also refer to this manual for expla-
nations on how to place originals.

< Facsimile Reference
Explains Facsimile functions and operations.

% Printer Reference
Explains Printer functions and operations.

< Scanner Reference
Explains Scanner functions and operations.

% Network Guide
Explains how to configure and operate the machine in a network environ-
ment, and use the software provided.
This manual covers all models, and includes descriptions of functions and
settings that might not be available on this machine. Images, illustrations, and
information about operating systems that are supported might also differ
slightly from those of this machine.



% Other manuals

* Manuals for This Machine

¢ Safety Information

* Quick Reference Copy Guide

® Quick Reference Fax Guide

¢ Quick Reference Printer Guide

¢ Quick Reference Scanner Guide

* PostScript 3 Supplement

¢ UNIX Supplement

* Manuals for DeskTopBinder Lite
* DeskTopBinder Lite Setup Guide
¢ DeskTopBinder Introduction Guide
¢ Auto Document Link Guide

& Note
0 Manuals provided are specific to machine types.

O Adobe Acrobat Reader/Adobe Reader must be installed in order to view the
manuals as PDF files.

O For “UNIX Supplement”, please visit our Web site or consult an authorized
dealer.

O “PostScript3 Supplement” and “UNIX Supplement” include descriptions of
functions and settings that might not be available on this machine.
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How to Read This Manual

Symbols

This manual uses the following symbols:

/\ WARNING:
Indicates important safety notes.
Ignoring these notes could result in serious injury or death. Be sure to read these

notes. They can be found in the “Safety Information” section of About This Ma-
chine.

/\ CAUTION:
Indicates important safety notes.
Ignoring these notes could result in moderate or minor injury, or damage to the

machine or to property. Be sure to read these notes. They can be found in the
“Safety Information” section of About This Machine.

*gklmportant

Indicates points to pay attention to when using the machine, and explanations
of likely causes of paper misfeeds, damage to originals, or loss of data. Be sure
to read these explanations.

& Note

Indicates supplementary explanations of the machine’s functions, and instruc-
tions on resolving user errors.

A Reference

This symbol is located at the end of sections. It indicates where you can find fur-
ther relevant information.

[]

Indicates the names of keys that appear on the machine’s display panel.

[]

Indicates the names of keys on the machine’s control panel.



Display Panel

This section describes configuration using the display panel when the printer

function is selected.

JobReset [Prt.Jobs| Menu

|
2

1. Operational status or messages

Displays current machine status, such as
“Ready”, “Offline”, and “Printing...”.

2. [JobReset]

Press to cancel the current print job. If
you press it when the machine is offline
and Hex Dump is selected, Hex Dump is
canceled.

3. [Prt.Jobs]

Press to display print jobs sent from a
computer.

4 Note

4 AMO200S

4. [Menu]

Press to display the menu to select the
following options:

e [Show Error Log]
Displays the error logs of print jobs
that are sent from a computer.

e [Form Feed]
Prints all the data left in the machine's
input buffer.

O When the power is turned on, the copier display is shown. This is a factory
default. This initial setting can be changed. See “System Settings”, General

Settings Guide.



Reading the Display and Using Keys

This section explains how to read the display and using the selection key for the

initial display.

1. Scroll keys

Press to move the cursor in each direc-
tion, step by step.

When the [A], [V], [»], or [ €] key ap-
pears in this manual, press the scroll key
of the same direction.

2. [OK] key
Press to set a selected item or entered nu-
meric value.

& Note

AMOB00S

3. [Escape] key
Press to cancel an operation or return to
the previous display.

4. Selection keys

Correspond to the function items at the
bottom line on the display. Example: Ba-
sic screen When the instruction “press
[JobReset]” appears in this manual, press
the left selection key.

O The Printer display is set as the default screen when the machine is turned on.
You can change the settings in [System Settings]. See General Settings Guide.



Printer Features Menu

The following explains settings and meanings of functions on Printer Feature.
Printer Feature screen appears when you press the [User Tools/Counter] key. For

details, see “Printer Features”, General Settings Guide.

« List/Test Print

Menu Description

Multiple Lists You can print the configuration page and er-
ror log.

Config. Page You can print the machine's current configu-
ration values.

Error Log You can print error logs listing all errors that
occurred during printing.

Menu List You can print a Menu List showing the ma-
chine's function menus.

PCL Config./Font Page You can print the current configuration and

installed PCL font list.

PS Config./Font Page

You can print the current configuration and
installed PostScript font list.

PDF Config./Font Page You can print the current configuration and
installed PDF font list.
This menu can be selected only when the op-
tional PostScript 3 unit is installed.

Hex Dump You can print in the Hex Dump mode.

« Maintenance

Menu

Description

Menu Protect

This function lets you protect menu settings
from accidental change. It makes it impossi-
ble to change menu settings with normal
procedures unless you perform the required
key operations.

In a network environment, only administra-
tors can make changes to menu settings.

List/Test Print Lock

You can lock the [List/Test Print] menu.

Delete All Temporary Jobs

You can delete all print jobs temporarily
stored in the machine.

Delete All Stored Jobs

You can delete to delete all print jobs stored
in the machine.

Image Density

You can adjust the image density.




« System

Menu

Description

Print Error Report

You can print an error report when a printer
Or Memory error occurs.

Auto Continue

You can select this to enable Auto Continue.
When it is On, printing continues after a sys-
tem error occurs.

Memory Overflow

Select this to have a memory overflow error
report printed.

Auto Delete Temporary Jobs

You can select to automatically delete print
jobs temporarily stored in the machine.

Auto Delete Stored Jobs

You can select to automatically delete print
jobs stored in the machine.

Memory Usage

You can select the amount of memory used
in Font Priority or Frame Priority, according
to paper size or resolution.

Duplex

You can select to have print on both sides of
each page.

Copies

You can specify the number of print sets.
This setting is disabled if the number of pag-
es to print has been specified with the printer
driver or another command.

Blank Page Print

You can select whether or not to print blank
pages.

Printer Language

You can specify the printer language.

Sub Paper Size

You can enable the Auto Substitute Paper
Size (A4 LT) feature.

Page Size

You can select the default paper size.

Letterhead Setting

You can rotate original images when printing.

When printing, original images are always
rotated by 180 degrees. Therefore, output
might not be as expected when printing onto
letterhead or preprinted paper requiring ori-
entation. Using this function, you can specify
image rotation.

Bypass Tray Priority

You can specify which of the two options,
(Printer) Driver / Command or Machine Set-
tings, has priority for determining the paper
size for the bypass tray.

Edge to Edge Print

You can select whether or not to print on the
entire sheet.

Default Printer Lang.

You can set the default printer language if
the machine cannot find the printer language
automatically.

Tray Switching

You can set to switch the paper tray.

RAM Disk

You can change the settings of the RAM disk.




+ Host Interface

Menu Description
1/0 Buffer You can set the size of the I/O Buffer. Nor-
mally it is not necessary to change this setting.
I/0 Timeout You can set how many seconds the machine
should wait before ending a print job. If data
from another port usually arrives in the mid-
dle of a print job, you should increase this
timeout period.
< PCL Menu
Menu Description
Orientation You can set the page orientation.
Form Lines You can set the number of lines per page.

Font Source

You can set the storage location of the de-
fault font.

Font Number

You can set the ID of the default font you
want to use.

Point Size You can set the point size you want to use for
the selected font.

Font Pitch You can set the number of characters per
inch for the selected font.

Symbol Set You can specify the set of print characters for

the selected font. The available options are as
follows:

Courier Font

You can select a courier font type.

Ext. A4 Width

You can extend the printing area width
when printing on A4 sheet with PCL.

Append CR to LF When set to On, a carriage return will follow
each line feed: CR=CR, LF=CR-LF, FF=CR-FF.
Resolution You can set the print resolution in dots per

inch.

% PS Menu (optional)

Menu

Description

Data Format

You can select a data format.

Resolution You can set the print resolution in dots per
inch.
Colour Setting You can make an RGB setting.

Colour Profile

You can set the colour profile.




« PDF Menu (optional)

Menu Description

Change PDF Password You can set the password for the PDF file ex-
ecuting PDF Direct Print.

PDF Group Password You can set the group password already
specified with DeskTopBinder Lite.

Resolution You can set the print resolution in dots per
inch.

Colour Setting You can make an RGB setting.

Colour Profile You can set the colour profile.

& Note

O Depending on which optional units you have installed or the printer lan-
guage you have selected, some options are not displayed.

O Depending on the security settings, you might not be able to set certain op-
tions.

O If you are using the machine that does not have Function Upgrade Option
type C1500 installed, some options are not displayed.

ye Reference
For details, see “Printer Features”, General Settings Guide.

For more information about copier features and system settings, see Copy
Reference and General Settings Guide.



Using the Bypass Tray

Setting Paper on the Bypass Tray

This section gives instructions for setting paper on the bypass tray.

For details about paper size and paper type, see “Recommended Paper Sizes and
Types”, About This Machine.

ﬂklmportant
O The following functions are disabled when printing from the bypass tray:

* Duplex printing
¢ Auto Tray Select
¢ Auto Tray Switching
* Rotating Collate

O When printing using the printer function, original images are always rotated
by 180 degrees (the orientation of images to be printed is opposite to that of
the copier function). When printing onto paper with specific orientation re-
quirements, such as envelopes and letterheads, be sure to rotate the paper
feed orientation to 180 degrees.

O OHP transparencies cannot be printed from the bypass tray. Use the One
Sheet bypass tray.

O Paper that is thicker than 163 g/m? (max.) cannot be printed from the bypass
tray. Print from the One Sheet bypass tray when using paper of that thickness.

ﬂ Open the bypass tray.

ALZ023S



ﬂ Lift up the paper guide release lever.

ALZ038S

B Adjust the paper guides to the paper size, and then gently insert paper face
up into the bypass tray.

ALZ024S

1. Extender

2. Paper guides

Open out the extender to support paper sizes larger than A4 [, 8!/, x11
.

If the paper guides are not flush against the paper, skewing and misfeeds
might occur.

Gently insert paper until it stops.

Do not stack paper over the limit mark, otherwise a skewed image or mis-
feeds might occur.

Fan the paper to get air between the sheets to avoid a multi-sheet feed.
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ﬂ Push down the paper guide release lever.

ALZ039S

B Set the paper size using the printer driver or the control panel.

& Note
O Paper within the following dimensions can be set in the bypass tray:

e Vertical: 90 - 305 mm (3.55 - 12 in.)
e Horizontal: 148 - 600 mm (5.83 - 23.62 in.)

O Be sure to set the paper with the side you want to print facing up in the by-
pass tray.

O The number of sheets that can be loaded in the bypass tray depends on the
paper type.
A Reference

For details about setting the paper size, see p.11 “Setting the Paper Size and
Paper Type of the Bypass Tray”.

For details about setting paper in the regular paper tray, see General Set-
tings Guide.

When loading custom size paper, see p.12 “Setting Custom Size Paper”.

When loading thick paper (over 90.2 g/m?) or envelopes, set paper size
and paper type. For details, see p.14 “Setting Thick Paper or Envelopes”.

When loading letterhead paper, pay attention to its orientation. See Gener-
al Settings Guide.



Setting the Paper Size and Paper Type of the Bypass Tray

This describes how to set paper size of the bypass tray. By default, use the printer
driver for setting paper size. For details, see the printer driver Help.

i@klmportant

O If you select [Machine Settings] from [Bypass Tray Priority] in [System] of [Printer
Features], set the paper size using the control panel. For details, see General
Settings Guide.

Setting the Paper Size Using the Control Panel

This procedure describes how to set paper size of the bypass tray using the con-
trol panel. If you select the printer driver to set paper size, this procedure is not
necessary.

ﬂ Press the [User Tools/Counter] key.

User Tools/Counter Clear Modes\

&
Clear/St
OO ==
Start aﬁa

Oon
@/&@m

AMOB01S

o

ﬂ Select [System Settings] using [ V] or [4 ], and then press the [ OK] key.

BElzer Tools 1/5 = [0K]
Counter

aystem settings

B Select [Tray Paper Settings] using [ V] or [4 ], and then press the [OK] key.

BEcvsten etfinzs 1/¢ = 0K
General Features

Tray Paper Settinzs

Timer Zettings
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ﬂ Select [Printer Bypass Paper Size] using [V ] or [4], and then press the [ OK]
key.

BT rav/Faper 2/0 +[0K]

Paper size:Tray 3

Frinter Bvpass Paper Si

Paper Twpe:Bwpazs Traw

B Select the paper size using the scroll keys, and then press the [ OK] key.

P.5ize:1-5.Bypass h/D +r[0K]
Feulh3 a1 )

16K [ 16K

Custom Size

B Press the [User Tools/Counter ] key to return to the default screen.

A Reference
See the printer driver Help about the settings from the printer drivers.

When loading thick paper or envelopes, set paper type. For details, see
p-14 “Setting Thick Paper or Envelopes”.

Setting Custom Size Paper

The following procedures are not required if you select the printer driver for the
settings. In that case, set the paper size using the printer driver.

ﬂlmportant

O If you select [Machine Settings] from [Bypass Tray Priority] in [System] of [Printer
Features] (see “Printer Features”, General Settings Guide), the settings made
using the control panel have priority over the printer driver settings.

Setting the Custom Size Paper Using the Control Panel

I] Press the [ User Tools/Counter] key.

User Tools/Counter Clear Modes\

EX

-
Main
Power

m@

AMO601S

(92)
Y}
=
—

ATITITIH

G

ASITICK.
D @9 €9 @ Eg




g Select [System Settings] using [ V] or [4 ], and then press the [ OK] key.

BElzer Tools 1/h +[0K]
Counter

oystem Settings

B Select [Tray Paper Settings] using [ Y] or [4 ], and then press the [ OK] key.

Bevstem setlings 172 *0K|
General Features

Tray Paper Settings

Timer Zettings

ﬂ Select [Printer Bypass Paper Size] using [ Y] or [4], and then press the [ OK]
key.

BT raw/Paper 200 ¥ [0K]
Paper SizeiTray 3

Frinter Bvpass Paper Size

Paper Twpe:Bwpaszss Traw

B select [Custom Size] using the scroll keys, and then press the [ OK] key.

F.5ize:Bvpass h /0 A OK]
{45950 T
Bk 16K [d
1EK3 Custom Size

B Enter the horizontal size of the paper using the number keys, and press
(]
Available size: 148 - 600 mm (5.83 - 23.62 in.)

Cusz.Size:Bypazs
Enter meazurement.

chriz.:linn:h

<h.83-23.82%

ﬂ Enter the vertical size of the paper using the number keys, and press [ ).
Available size: 90 - 305 mm (3.55 - 12 in.)

Cusz.Size:Bypazs
Enter meazurement.

Yert. |:| inch

<3.55-12.00%

13



8 Press the [ User Tools/Counter ] key to return to the default screen.

& Note

O If the printer driver is not used, select [Machine Settings] from [Bypass Tray
Priority] in [System] of [Printer Features] (see “Printer Features”, General Set-
tings Guide). Set paper size using the control panel.

A Reference
For printer driver settings, see the printer driver Help.

Setting Thick Paper or Envelopes

The following procedures are not required if you select the printer driver for the
settings. In that case, set the paper size using the printer driver.

ﬂlmportant

O If you select [Machine Settings] from [Bypass Tray Priority] in [System] of [Printer
Features] (see “Printer Features”, General Settings Guide), the settings made
using the control panel have priority over the printer driver settings.

O Do not load OHP transparencies onto the bypass tray. Use the One Sheet By-
pass tray.

Setting Paper Type Using the Control Panel

I] Press the [ User Tools/Counter] key.

User Tools/Counter Clear Modes\
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g Select [System Settings] using [ V] or [4 ], and then press the [ OK] key.
Ellzer Tools 178 (0K

Counter

syztem Betlings

B Select [Tray Paper Settings] using [ Y] or [4 ], and then press the [ OK] key.

BEavzten Settings 172 ¥ [0KE]
General Features

Tlmer Eettlngs




ﬂ Select [Paper Type: Bypass Tray] using [ Y] or [4 ], and then press the [OK]
key.
ETrayIF‘aper 20 ¥
Paper size:Tray 3
Frinter Bvpass Paper Size

Paper Tyvpe:Bvpazs Traw

B Select paper type from the menu using [ V] or[4 ], and then press the [ OK]
key.
F.Tvpe iBvpazs /5 ¥
Bond Paper
Cardstock

Ervelope

ﬂ Press the [ User Tools/Counter ] key to return to the default screen.

& Note

O The settings made will remain valid until they are reset again. After print-
ing on thick paper or envelopes, be sure to clear settings for the next user.

O When printing onto envelopes, push down the Envelope lever to the Enve-
lope position. When printing is completed, push the Envelope lever up to
the normal position. Do not move the lever up or down during printing.

—

AMO006S

A Reference
For the printer driver settings, see the printer driver Help.

For details about printing onto envelopes, see “When copying onto enve-
lopes”, Copy Reference.
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Using the One Sheet Bypass Tray

Inserting Paper into the One Sheet Bypass Tray

This section gives instructions for setting paper on the One Sheet bypass tray.

For details about paper size and paper type, see “Recommended Paper Sizes and
Types”, About This Machine.

ﬂklmportant
O The following functions are disabled when printing from the One Sheet by-
pass tray:

* Duplex printing
e Auto Tray Select
¢ Auto Tray Switching
* Rotating Collate

O Use the One Sheet bypass tray to print OHP transparencies. Do not load onto
other paper trays.

O Be sure to open the One Sheet output tray. A sheet loaded on the One Sheet
bypass tray is printed from the One Sheet output tray only.

[ Use the One Sheet Bypass tray to print on paper that is thicker than 163 g/m?

(max. 220 g/m?). Do not use other trays, as paper jams and other malfunc-
tions will occur.

O You cannot print or insert paper into the One Sheet Bypass tray during printing.

O Be sure not to leave any paper on the One Sheet Bypass tray or on the One
Sheet Output tray, as this will cause a malfunction. After each print job, be
sure to remove any printed sheets from the One Sheet Output tray.

O Be sure to close the One Sheet bypass tray and the One Sheet output tray after
using them. If you do not close these trays, other trays cannot be used.

ﬂ Open the bypass tray.

ALZ037S



ﬂ Open the One Sheet bypass tray.

ALZ030S

B Open the One Sheet output tray.

The sheet inserted into the One Sheet bypass tray is printed out only from the
One Sheet output tray.

ALZ040S

ﬂ Adjust the paper guides to the paper size, and then gently insert a sheet
face up into the One Sheet bypass tray.

If the paper guides are not flush against the paper, skewing and misfeeds
might occur.

AMOO011S

1. Paper Guide

* Gently insert a sheet until the machine pulls it into the tray automatically.
If the sheet is not inserted straight, reinsert it.

* Do not insert multiple sheets. The One Sheet bypass tray is only available
for one sheet.

 If paper is left on the One Sheet output tray, you cannot insert paper into
the One Sheet bypass tray.

17
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B Set paper size using the printer driver and the control panel.

For details, see p.19 “Setting the Paper Size and Paper Type of the One Sheet
Bypass Tray”.

& Note

O Paper within the following dimensions can be set in the One Sheet bypass
tray:
e Vertical: 90 - 305 mm (3.55 - 12 in.)
e Horizontal: 148 - 600 mm (5.83 - 23.62 in.)

O Be sure to set the paper with the side you want to print facing up in the One
Sheet bypass tray.

O The number of sheets that can be loaded in the One Sheet bypass tray de-
pends on the paper type.

A Reference
For details about setting paper in the regular paper tray, see General Set-
tings Guide.
When loading custom size paper, see p.20 “Setting Custom Size Paper”.

When loading thick paper (over 90.2 g/ m?), OHP transparencies, or enve-
lopes, set paper size and paper type. For details, see p.22 “Setting Thick Pa-
per, OHP Transparencies, or Envelopes”.

When loading letterhead paper, pay attention to its orientation. See Gener-
al Settings Guide.



Setting the Paper Size and Paper Type of the One Sheet Bypass Tray

This describes how to set paper size and paper type of the One Sheet bypass tray.

To print using the One Sheet Bypass tray, set the paper size and paper type using
the printer driver and the control panel.

ﬂlmportant

O When setting the paper size and paper type for the One Sheet Bypass tray, set-
tings made using the printer driver and the control panel must be the same.
If the settings for the printer driver and the machine do not correspond, print-

ing is not possible.

Setting the Paper Size

ﬂ Set the paper size using the printer driver.

EI Press the [ User Tools/Counter] key.
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B Select [System Settings] using [ V] or [4 ], and then press the [ OK] key.

BElzer Tools

1/5 = [0K]

Counter

syztem Betlings

ﬂ Select [Tray Paper Settings] using [ Y] or [4 ], and then press the [ OK] key.

[Ecvzten settings

172 =[0K]

General Features

Timer Settinzs

Tray Paper Zettings
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B Select [Paper Size: 1-Sheet Bypass] using [ V] or [4 ], and then press the [ OK]
key.

Trav/Paper 175 ¥[0K]
g:1-5heet Bwpass
Paper SizeiTray 1

Paper Size:Tray 2

Paper Siz

B Select the paper size using the scroll keys, and then press the [ OK] key.

P.5ize:Byvpass B/ g [OK]
45953 Fiu s
qK 16K [
16K Custom Size

ﬂ Press the [User Tools/Counter ] key to return to the default screen.

A Reference
See the printer driver Help about the settings from the printer drivers.
When loading thick paper, envelopes, or OHP transparencies, set paper

type. For details, see p.22 “Setting Thick Paper, OHP Transparencies, or
Envelopes”.

Setting Custom Size Paper

i@klmportant

O When setting the paper size for the One Sheet Bypass tray, the settings using
the printer driver and the control panel must be the same. If the settings for
the printer driver and the machine do not correspond, printing cannot be
done.

ﬂ Set the paper size using the printer driver.
ﬂ Press the [User Tools/Counter] key.

User Tools/Counter Clear Modes\
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B Select [System Settings] using [ V] or [4 ], and then press the [ OK] key.

BElzer Tools 1/h +[0K]
Counter

oystem Settings

ﬂ Select [Tray Paper Settings] using [ Y] or [4 ], and then press the [ OK] key.

Bevstem setlings 172 *0K|
General Features

Tray Paper Settings

Timer Zettings

B Select [Paper Size: 1-Sheet Bypass] using [ ¥ ] or [ 4 ], and then press the [ OK] key.
Tray/Paper 178 ¥ [0K]

Faper Size:l-Sheet Bvpass

Faper SizeiTray 1
Paper Size:iTray 2

O setect [Custom Size] using the scroll keys, and then press the [ OK] key.

P.5ize:1-5.Bypazs b5 45#[0K]
T3 i
16K [ 16K

Cuztom 3ize

ﬂ Enter the horizontal size of the paper using the number keys, and press [ ).
Enter the same size as you set in the printer driver.
Available size: 148 - 600 mm (5.83 - 23.62 in.)
Cuz.Size:1-Zheet Bypass
Enter measurement.

Hu:nriz.l:linn:h

<h.Bd-23.62

8 Enter the vertical size of the paper using the number keys, and press [ #].
Enter the same size as you set in the printer driver.
Available size: 90 - 305 mm (3.55 - 12 in.)
Cuz.Size:1-Zheet Bypass
Enter measurement.

Yert. :l inch

<a.00-12. 00

2]
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g Press the [User Tools/Counter] key to return to the default screen.

A Reference
For printer driver settings, see the printer driver Help.

Setting Thick Paper, OHP Transparencies, or Envelopes

To print using the One Sheet Bypass tray, set the paper type using the printer
driver and the control panel.

i@klmportant

O To set the paper type for the One Sheet Bypass tray, the settings using the
printer driver and the control panel must be the same. If the settings for the
printer driver and the machine do not correspond, printing cannot be done.

O When loading an OHP transparency onto the One Sheet bypass tray, set the
sheet in the [/ direction. Do not try to set the sheet in the [ direction.

3 OHP Transparencies can only be printed in A4 [J or 8!/, x 11 [J sizes. Do not
print on any other size.

O When printing OHP Transparencies, use the printer driver and control panel
to set the output colour. OHP Transparencies cannot be printed in B&W.

ﬂ Set paper type using the printer driver.
EI Press the [ User Tools/Counter] key.
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8 Select [System Settings] using [ V] or [4 ], and then press the [ OK] key.

BElzer Tools 1/5 =[0K]
Counter

syztem Betlings

ﬂ Select [Tray Paper Settings] using [ Y] or [4 ], and then press the [ OK] key.

BEcvsten etfinzs 1/¢ = 0K
General Features

Tray Paper Settings

Timer settings




B Select [Paper Type: 1-Sheet Bypass] using [ V] or [A ], and then press the [ OK]
key.

Tray/Paper /5 +[0K]

Paper Twpe:l-sheet Bwpass
Paper Twpe:iTray 1

Paper Twpe:Tray 2

O setect a paper type from the menu using [ Y] or [4], and then press the
[OK] key.

P.Tvpe:1-5.Bvpazs 478 ¥[0KE]
Bond Paper
Cardstock

OHP (Transparency)

ﬂ Press the [ User Tools/Counter ] key to return to the default screen.

& Note

O The settings made will remain valid until they are reset again. After print-
ing on OHP transparencies, thick paper, or envelopes, be sure to clear set-
tings for the next user.

O When printing onto envelopes, push down the Envelope lever to the Enve-
lope position. When printing is completed, push the Envelope lever up to
the normal position. Do not move the lever up or down during printing.

—

AMO006S

p Reference
For printer driver settings, see the printer driver Help.

For details about printing onto envelopes, see “When copying onto enve-
lopes”, Copy Reference.

23



24



e
1. Preparing the Machine

Confirming the Connection Method

This machine supports network and local connection.

Before installing the printer driver, check how the machine is connected. Follow
the driver installation procedure that is appropriate to the connection method.

Network Connection

This machine can be used as a Windows printing port or network printer.

Using This Machine as the Windows Printing port

Network connections can be established through Ethernet, IEEE 802.11b, and
IEEE 1394 (IPv4 over 1394).

Available ports are determined based on the combination of Windows operating
system version and connection method used.

SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client SmartDeviceMonitor for Client
-TCP/IP -TCP/IP -TCP/P -TCP/IP
-IPP -IPP -IPP -IPP
- . Standard TCP/IP <. Standard TCP/IP . LPR
I LPR I LPR I
Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

27220358

< Windows 95/ 98

Connection Method Available Ports
Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port
IEEE 1394 (IPv4 over 1394) None

25



Preparing the Machine

< Windows Me
Connection Method Available Ports
Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

R
*o*

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port

Windows 2000

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP

LPR port
IEEE 1394 (IPv4 over 1394) None
«» Windows XP
Connection Method Available Ports
Ethernet / IEEE 802.11b SmartDeviceMonitor for Client port

2
**

R
**

Standard TCP/IP
LPR port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

Windows Server 2003

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
Standard TCP/IP
LPR port

IEEE 1394 (IPv4 over 1394)

SmartDeviceMonitor for Client port
Standard TCP/IP

Windows NT 4.0

Connection Method

Available Ports

Ethernet / IEEE 802.11b

SmartDeviceMonitor for Client port
LPR port

IEEE 1394 (IPv4 over 1394)

None

p Reference

See the explanation about how to install the printer driver for each type of
port. For the SmartDeviceMonitor for Client port, see p.30 “Using the Smart-
DeviceMonitor for Client Port”.

For the Standard TCP/IP port, see p.36 “Using the Standard TCP/IP Port”.
For the LPR port, see p.38 “Using the LPR Port”.



Confirming the Connection Method

Using as a network printer

This machine can be used as the Windows network printer, the NetWare print
server, or the NetWare remote printer.

Windows 2000/XP
Windows Server 2003
Windows NT 4.0 NetWare NetWare
Print Server Print Server File Server
I 95
S S

Windows 95/98/Me Windows 2000 Windows XP/ Windows NT 4.0
Server 2003

2720368

& Note
O In an IPv6 environment, Netware servers cannot be used.

» Reference
See the explanation about how to install the printer driver for each type of
network printer.
For the Windows network printer, see p.40 “Using as a Windows Network
Printer”.

For the NetWare print server and remote printer, see p.42 “Using as a Net-
Ware Print Server / Remote Printer”.
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Preparing the Machine

Local Connection

Local connections can be established via parallel, USB, IEEE 1394 (SCSI print),
and Bluetooth connections.

Windows operating system version determines the available connection meth-
ods.

Windows 95:
Parallel connections

Windows 98:
Parallel connections

Windows 98 SE / Me:
USB and Parallel connections

Windows 2000:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

Windows XP:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

Windows Server 2003:
USB, Parallel, IEEE 1394 (SCSI print), and Bluetooth connections

Windows NT 4.0:
Parallel connections

p Reference

See the explanation about how to install the printer driver for each method of
connection.

For the USB connection, see p.45 “Installing the Printer Driver Using USB”.
For the parallel connection, see p.50 “Printing with Parallel Connection”.

For the IEEE 1394 (SCSI print) connection, see p.52 “Installing the Printer
Driver Using IEEE 1394 (SCSI print)”.

For the Bluetooth connection, see p.56 “Printing with Bluetooth Connection”.



Installing the Printer Driver

Installing the Printer Driver

This section explains how to install the printer driver. There are two ways to in-
stall the printer driver: using Quick Install, which installs the settings at once, or
installing the appropriate driver according to the port you want to use.

Quick Install

Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, and Windows NT 4.0
users can easily install this software using the supplied CD-ROM.

Using Quick Install, the PCL printer driver and /or RPCS printer driver, Desk-
TopBinder Lite and SmartDeviceMonitor for Client are installed under network
environment, and the TCP/IP port will be set.

iﬁklmportant

O To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrator.

O If you connect using USB, refer to p.45 “Installing the Printer Driver Using
USB” and install the printer driver.
ﬂ Quit all applications currently running.

B 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.
Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.
B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [Quick Install].
The software license agreement appears in the [License Agreement] dialog box.
B After reading the agreement, click [l accept the agreement.], and then click
[Next >].

E Select the machine model you want to use in the [Select Printer] dialog box.

For network connection via TCP/IP, select the machine whose IP address is
displayed in [Connect To].

For parallel connection, select the machine whose printer port is displayed in
[Connect To].

U click [install].
The printer driver installation starts.

29
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Preparing the Machine

B click [Finish].

A message about restarting the computer appears. Restart the computer to
complete installation.

g Click [Exit] in the first dialog box of the installer, and then take out the CD-ROM.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Select a machine to whose IP address is displayed in [Connect To] to install
SmartDeviceMonitor for Client when using TCP/IP.

/O Reference

Quick Install is not available unless bidirectional communication between
the machine and computer is enabled via parallel connection. See p.61 “If
Bidirectional Communication Is Disabled” for details about bidirectional
communication between the machine and computer.

Installing the Printer Driver for the Selected Port

Using the SmartDeviceMonitor for Client Port

iﬁklmportant

O To install SmartDeviceMonitor for Client under Windows 2000 / XP Profes-
sional, Windows Server 2003, and Windows NT 4.0, you must have an ac-
count that has Manage Printers permission. Log on as an Administrator.

O Install SmartDeviceMonitor for Client before installing the printer driver
when using the SmartDeviceMonitor for Client port.

Installing SmartDeviceMonitor for Client

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [DeskTopBinder - SmartDeviceMonitor for Client].

B Select an interface language, and then click [Next >].
The default interface language is English.



Installing the Printer Driver

E The message to quit all other applications appears. Quit all applications,
and then click [Next >].

ﬂ The software license agreement appears in the [License Agreement] dialog
box. After reading through its contents, click [Yes].

B Click [Full install] or [Custom Install].

[Full install] installs all required applications: DeskTopBinder Lite and Smart-
DeviceMonitor for Client.

[Custom Install] installs selected applications.
g Follow the instructions on the display and click [Next >] to proceed next step.

[[D After the installation is completed, select one of the options to restart the
computer either now or later, and click [Complete].

Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

Changing the Port Settings for SmartDeviceMonitor for Client

Follow the procedure below to change the SmartDeviceMonitor for Client set-
tings, such as TCP/IP timeout, recovery/parallel printing, and printer groups.

Windows 95 / 98:

ﬂ Open the [Printers] window from the [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

B Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.

Windows 2000 / Windows NT 4.0:

ﬂ Open [Printers] window from [Start] menu.

ﬂ In the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].
B On the [Ports] tab, click [Configure Port].

The [Configuration] dialog box appears.
31
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Preparing the Machine

Windows XP, Windows Server 2003:

ﬂ Open the [Printers and Faxes] window from the [Start] menu.
The [Printers and Faxes] window appears.

g Click the icon of the machine you want to use. On the [File] menu, click
[Properties]. The printer properties appear.

B Click the [Ports] tab, and then click [Configure Port].
The [Port Configuration] dialog box appears.

& Note
O For TCP/IP, timeout setting can be configured.

O User, proxy, and timeout settings can be configured for IPP.

O If no settings on the [Recovery/Parallel Printing] tab are available, follow the
procedure below.

@ Click [Cancel] to close the [Port Configuration:] dialog box.

@ Start SmartDeviceMonitor for Client, and then right-click the SmartDe-
viceMonitor for Client icon on the tasktray.

® Point to [Properties], and then click [Extended Features Settings].
@ Select the [Set Recovery/Parallel Printing for each port] check box.
® Click [OK] to close the [Extended Features Settings] dialog box.

/O Reference

For information about these settings, see “Using SmartDeviceMonitor for
Client”, Network Guide, or SmartDeviceMonitor for Client Help.

Installing the PCL or RPCS Printer Driver (TCP/IP)

ﬂlmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

ﬂ Click [PCL/RPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].



Installing the Printer Driver

E Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Click [Next >].

8 Select the machine model you want to use.
The printer name can be changed in the [Change settings for ‘Printer Name'] box.

g Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

M Click [Port:], and then click [Add].

[I] Click [SmartDeviceMonitor], and then click [OK].

(B Click [TCPAP], and then click [Search].
A list of printers using TCP/IP appears.

[B Select the printer you want to use, and then click [OK].

Only printers that respond to a broadcast from the computer appear. To use
a machine not listed here, click [Specify Address], and then enter the IP address
or host name of the machine.

ﬂ] Check that the port of the selected printer is displayed in [Port:].

iE Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic character or symbol
can be entered.

[E Select the [Default Printer] check box to configure the printer as default.

W click [Continue].
Installation starts.

[E] After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

4 Note

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check statistics about the number of sheets which each user
prints. For details, see SmartDeviceMonitor for Admin Help.

O Auto Run may not work with certain operating system settings. If this hap-
pens, launch “Setup.exe” on the CD-ROM root directory.

O Under Windows 95 / 98 / Me, you cannot add an IP address partially sim-
ilar to the one already used. For example, if “192.168.0.2” is in use,
“192.168.0.2xx” cannot be used. Similarly, if “192.168.0.20” is in use,
“192.168.0.2” cannot be used. 33
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Preparing the Machine

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Installing the PCL or RPCS Printer Driver (IPP)

ﬁlmportant

O To install printer driver under Windows 2000 / XP Professional, Windows
Server 2003, and Windows NT 4.0, you must have an account that has Man-
age Printers permission. Log on as an Administrators or Power Users group
member.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O Click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for ‘Printer Name'] box.

B Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

g Click [Port:], and then click [Add].
[[D Click [SmartDeviceMonitor], and then click [OK].
[I] Click [IPP].



Installing the Printer Driver

[B In the [Printer URL] box, enter “http://printer's address/printer” as the print-
er's address.

If the server authentication is issued, to enable SSL (a protocol for encrypted
communication), enter “https:/ /printer's address/printer” (Internet Explor-
er 5.01, or a higher version must be installed).

(example IP address: 192.168.15.16)
http://192.168.15.16/printer
https://192.168.15.16/printer
You can enter “http:/ /printer's address/ipp” as the printer's address.

[B Enter a name for identifying the printer in [IPP Port Name]. Use a name dif-
ferent from the one of any existing port.

If a name is not specified here, the address entered in the [Printer URL] box be-
comes the IPP port name.

ﬂ] Click [Detailed Settings] to make necessary settings.
For information about the settings, see SmartDeviceMonitor for Client Help.

B cick [oK].
[E Check that the port of the selected printer is displayed in [Port:].

m Set a user code, if necessary.

Up to 8 numeric characters can be entered. No alphabetic characters or sym-
bols can be entered.

[E] Select the [Default Printer] check box to configure the printer as default.

[D Click [Continue].
Installation starts.

EID After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

O Setting a user code allows a SmartDeviceMonitor for Admin user to dis-
play and check the number of sheets each user prints. For details, see
SmartDeviceMonitor for Admin Help.
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Preparing the Machine

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.

Using the Standard TCP/IP Port

This describes how to install the PCL or RPCS printer driver using the TCP/IP
port.

ﬁlmportant

O To install this printer driver under Windows 2000 / XP Professional, and
Windows Server 2003, you must have an account that has Manage Printers
permission. Log on as an Administrators or Power Users group member.

O In an IPv6 environment, you cannot use the Standard TCP/IP Port. Use the
SmartDeviceMonitor for Client port.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select a printer driver you want to use in the [Select Program] dialog box.

You can select several printer drivers.
U crick [Next >].

B Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[ Click [Port:], and then click [Add].



Installing the Printer Driver

ﬂ] Click [Standard TCP/IP Port], and then click [OK].

Configure the Standard TCP/IP port settings, and then see Windows Help if
[Standard TCP/IP Port] does not appear.

[EJ Click [Next >] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.

[B Enter the printer name or IP address in the [Printer Name or IP Address] box.

The [Port Name] text box automatically obtains a port name. Change this name
if necessary.

When the device selection appears, select “RICOH NetworkPrinter Driver C
Model”.

ﬂ] Click [Next >].

iE Click [Finish] in the [Add Standard TCP/IP Printer Port Wizard] dialog box.
The installation start dialog box reappears.

[E Check that the port of the selected printer is displayed in [Port:].
m Configure the default printer as necessary.

[E] Click [Continue].
The printer driver installation starts.

[E] After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using the LPR Port

This describes how to install the PCL or RPCS printer driver using the LPR port.

ﬂklmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

Fd 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

E Select a printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Select the machine model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

8 Click [Next >].

g Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[ crick [Port:], and then click [Add].

ﬂ] Click [LPR Port], and then click [OK].
If [LPR Port] does not appear, see Windows Help and install it.

[EJ Enter the printer's IP address in the [Name or address of server providing Ipd]
box.

[B Enter “1p” in the [Name of printer or print queue on that server] box, and then click
[OK].
The port is added.



Installing the Printer Driver

ﬂ] Check that the port of the selected printer is displayed in [Port:].
[B Configure the default printer as necessary.

[[ﬂ Click [Continue].
The printer driver installation starts.

[ﬂ After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note
O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a Windows Network Printer

This describes how to install the PCL or RPCS printer driver when using the
printer as a Windows network printer.

To use the print server, install the printer driver by selecting “Network printer
server”, and then select the Windows 2000 / XP, Windows Server 2003, or Win-
dows NT 4.0 shared printer.

This section assumes that the client has already been configured to communicate
with a Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0 print
server. Do not begin the following procedure before the client is set up and con-
figured correctly.

iﬁklmportant

O To install the printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

O If you print with a print server connected to the printer using the SmartDe-
viceMonitor port, Recovery Printing and Parallel Printing cannot be used
from the client.

O If you print with a Windows XP or Windows Server 2003 print server, notifi-
cation functions of SmartDeviceMonitor may not be used with the client.

O If you print with a Windows NT 4.0 print server, install the printer driver be-
fore you connect the print server to the printer.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.

B insert the CD-ROM into the CD-ROM drive.
The installer starts.

8 Select an interface language, and then click [OK].
The default interface language is English.

O Click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

ﬂ Click [Next >].



Using as a Windows Network Printer

B Select the [Printer Name] check box to select the printer models you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.
The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[ Click [Port:], and then click [Add].

@ Click [Network Printer], and then click [OK].

[B Double-click the computer name you want to use as a print server in the
[Browse for Printer] window.

[B Select the printer you want to use, and then click [OK].
ﬂ] Check that the port of the selected printer is displayed in [Port:].

[B Configure the user code as necessary.

For an RPCS printer driver, a user code can be set after the printer driver in-
stallation. For information about user code, see the printer driver Help.

m Select the [Default Printer] check box to configure the printer as default.

[ﬂ Click [Continue].
The printer driver installation starts.

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

p Reference

A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Using as a NetWare Print Server / Remote
Printer

This describes how to set up the Windows computer used as the NetWare client.

iﬁklmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

O In an IPv6 environment, Netware servers cannot be used.

The following explanation assumes NetWare Client is installed on the client
computer and the NetWare server environment is correctly set up. Install all nec-
essary client applications before following this procedure.

Set up the printer driver while logging on to the NetWare file server.
The following values are used in the example:

¢ Operating system: Windows 98

¢ NetWare version: 4.1

¢ File server name: CAREE

¢ Queue name: R-QUEUE

) 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work with certain operating system settings. In that case,
launch “Setup.exe” on the CD-ROM root directory.

ﬂ Select an interface language, and then click [OK].
The default interface language is English.

B Click [PCL/RPCS Printer Drivers].

ﬂ The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

B Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

[ click (Next >].

ﬂ Select the [Printer Name] check box to select the printer model you want to use.
The printer name can be changed in the [Change settings for ‘Printer Name'] box.

B Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.



Using as a NetWare Print Server / Remote Printer

B click [Port:], and then click [Add].
[m Click [Network Printer], and then click [OK].

ﬂ] Double-click the name of the NetWare file server on the network tree.
The created queue is displayed.

[E Select the print queue, and then click [OK].
[B Check that the port of the selected printer is displayed in [Port:].

0 click [Continue].
The printer driver installation starts.

B click [Finish] in the [Select Program] dialog box.

m After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

[ﬂ After restarting the computer, launch the [Printers] window, and then open
the printer properties.
Under Windows XP or Windows Server 2003, open the printer properties
from the [Printers and Faxes] window.

[EJ On the [Printer Settings] tab, clear the [Form Feed] and [Enable Banner] check
boxes.

Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, click
the [NetWare setting] tab.

Do not select these check boxes since they are automatically selected by the
printer driver. If you select the check boxes, the printer may not print correctly.

[E] Click [OK] to close the printer properties dialog box.

& Note

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O The protocol is set to inactive as default. Enable it using Web Image Mon-
itor or Telnet.
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Form Feed

Do not use NetWare to configure form feed. Form feed is controlled by the print-
er driver on Windows. If NetWare form feed is configured, the printer may not
print properly.

Follow the procedure below to disable form feed according to the operating sys-
tem used:

e Under Windows 95 / 98 / Me, clear the [Form feed] check box on the [Printer
Settings] tab in the printer properties dialog box.

¢ Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Form feed] check box on the [NetWare Settings] tab in the printer properties
dialog box.

Banner Page

Do not use NetWare to configure a banner page.

Follow the procedure below to disable banner pages according to the operating
system used:

e Under Windows 95 / 98 / Me, clear the [Enable banner] check box on the [Print-
er Settings] tab in the printer properties dialog box.

e Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, clear
the [Enable banner] check box on the [NetWare Settings] tab in the printer prop-
erties dialog box.

Printing after Resetting the Printer

Printer to print server connection requires 30 - 40 seconds to resume after the
printer is reset. During this period, jobs may be accepted (depending on Net-
Ware specifications) but not printed.

To print after resetting the printer as the remote printer, check on the print server
that the remote printer is disconnected, or wait for two minutes before trying to
print.
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Installing the Printer Driver Using USB

This section explains how to install printer drivers using USB.

Before installing, check that only the operating system is running on the compu-
ter and no print jobs are in progress.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

Windows Me - USB

ﬂlmportant
O Installation via USB is not possible under Windows 95 / 98. Upgrade to Win-
dows Me or later.

O Download USB Printing Support for Windows Me from the supplier's Web site.

When USB is first used, the plug and play function starts and the [New Hardware
Found], [Device Driver Wizard], or [Add New Hardware Wizard] dialog box appears, de-
pending on the operating system.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.
ﬂ Download USB Printing Support from the supplier's Web site.

Use a search to find the model name, and then download USB Printing Sup-
port from the supplier's Web site.

Save it where you can locate it easily.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

8 In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

ﬂ Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

B Specify the location where USB Printing Support is located, and then click
[Next >].

B Check the location, and then click [Next >].
USB Printing Support is installed.

U click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.
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B Insert the printer driver. Click [Search for the best driver for your device. [Recom-
mended]], and then click [Next >].

g Select the [Specify a location:] check box, and then click [Browse...].
The [Browse for Folder] dialog box appears.

[[D Insert the CD-ROM into the CD-ROM drive.

& Note
3 When Auto Run starts, click [Exit].

O To disable Auto Run, press the [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

ﬂ] Specify the location where the source files of the printer driver are stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN9X_ME\ (Language)\DISK1

¢ PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN9X_ME\ (Language) \DISK1

¢ PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN9X_ME\ (Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN9X_ME\ (Language)\DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:ADRIVERS\PS\WIN9X_ME\ (Language)\DISK1
[E Check the location, and then click [Next >].
Add Printer Wizard starts.

B click [Finish].
Installation is complete. If installation is successful, the icon of the printer
connected to the “USB001” port is added to the [Printers] window.

& Note

O The number after “USB” varies depending on the number of printers con-
nected.

O Itis not necessary to reinstall USB Printing Support when connecting a dif-
ferent machine via USB interface when USB Printing Support is installed.

O After installing USB Printing Support, if the printer driver is not installed,
follow the plug-and-play instructions of the printer.
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Windows 2000 - USB

iﬁklmportant

O Installing a printer driver requires Administrator permission. Log on using
an account that has Administrator permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

ﬂ In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

B Select the [Specify location] check box, and then click [Next >].

O 1nsert the CD-ROM into the CD-ROM drive.
When Auto Run starts, click [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

B Specify the location where the source files of the printer driver is stored.

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\ (Language) \DISK1

¢ PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

¢ PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\ DISK1

e PCL6
D:\ADRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\ADRIVERS\PS\WIN2K_XP\(Language) \DISK1

E Check the printer driver location, and then click [OK].
U crick [Next >].
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B click [Finish].

If the printer driver has already been installed, plug and play is enabled, and
the icon of the printer connected to the “USB001” port is added to the [Printers]
window.

& Note

O The number after “USB” varies depending on the number of printers con-
nected.

Windows XP, Windows Server 2003 - USB

ﬂlmportant
O Installing a printer driver requires Administrators permission. Log on using

an account that has Administrators permission.

When USB is first used, Found New Hardware Wizard starts, and USB Printing
Support is installed automatically.

If the printer driver has already been installed, plug and play is enabled, and the
icon of the printer connected to the “USB” port is added to the [Printers] window.

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

If the printer driver is not installed, follow the plug-and-play instructions of the
printer to install it from the supplied CD-ROM.

ﬂ Connect the machine to the computer using the USB cable.
Connect the USB cable firmly.

g In the Found New Hardware Wizard display, click [Search for a suitable driver
for my device [recommended]], and then click [Next >].

Bl insert the CD-ROM into the CD-ROM drive.

If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.



Installing the Printer Driver Using USB

ﬂ Select the [Include this location in the search] check box under [Search for the best
driver in these location], and then click [Browse] to select the printer driver lo-
cation.

If the CD-ROM drive is D, the source files of the printer driver are stored in

the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\ (Language) \DISK1

¢ PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

e PCL 5e (for B & W printing)
D:\DRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:ADRIVERS\PS\WIN2K_XP\(Language) \DISK1

B Check the printer driver location, and then click [Next >].
(3 ciick [continue].
 click [Finish].

If installation is successful, the icon of the printer connected to the “USB001”
port is added to the [Printers and Faxes] window.

& Note
O The number after “USB” varies depending on the number of printers connected.
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Printing with Parallel Connection

This describes how to install the PCL or RPCS printer driver when using the par-
allel port.

To use a machine connected using a parallel interface, click [LPT1] when install-
ing the printer driver.

ﬂklmportant

O To install this printer driver under Windows 2000 / XP Professional, Win-
dows Server 2003, and Windows NT 4.0, you must have an account that has
Manage Printers permission. Log on as an Administrators or Power Users
group member.

Installing the PCL or RPCS Printer Driver

ﬂ Quit all applications currently running.
B insert the CD-ROM into the CD-ROM drive.

The installer starts.

B Select an interface language, and then click [OK].
The default interface language is English.

O click [PCLRPCS Printer Drivers].

B The software license agreement appears in the [License Agreement] dialog box.
After reading the agreement, click [l accept the agreement.], and then click [Next >].

E Select the printer driver you want to use in the [Select Program] dialog box.
You can select several printer drivers.

U Click [Next>].

8 Select the [Printer Name] check box to select the printer model you want to use.
The printer name can be changed in the [Change settings for 'Printer Name'] box.

g Double-click the printer name to display the printer settings.

The details shown in [Comment:], [Driver:], and [Port:] vary depending on the
operating system, printer model, and port.

[ Check that [LPT1:] is shown in [Port:].
[i] Select the [Default Printer] check box to configure the printer as default.

[ cClick [Finish].
The printer driver installation starts.



Printing with Parallel Connection

[B After the installation is completed, select one of the options to restart the
computer either now or later, and then click [Finish].

Restart the computer to complete installation.

& Note u

O To stop installation of the selected software, click [Cancel] before installa-
tion is complete.

O Auto Run may not work with certain operating system settings. In that
case, launch “Setup.exe” on the CD-ROM root directory.

A Reference
A message appears if there is a newer version of the printer driver already
installed. If there is, you cannot install the printer driver using Auto Run.
If you still want to install the printer driver, use [Add Printer]. See “When a
Message Appears during Installation of the Printer Driver”, Trouble
Shooting.
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Installing the Printer Driver Using IEEE 1394
(SCSI print)

The printer drivers can be installed from the supplied CD-ROM provided with
this machine.

iﬁklmportant
O Quit all applications currently running, and do not print during installation.

O Do not connect IEEE 1394 or USB devices to the computer or turn on another
printers during installation.

O Before uninstalling the printer driver, check that the IEEE 1394 interface cable
is disconnected from the computer.

O SCSI print must be set to “active” from the control panel. For details, see Net-
work Guide.

& Note

O This machine can receive print data from one computer at a time only. A mes-
sage may appear if print jobs from different computers collide.

O If jobs collide, the first received job is printed first.

O When the printer driver is properly installed, connecting or disconnecting the
optional IEEE 1394 cable causes the printer icon to change.

Windows 2000

This describes how to install the printer driver to the computer with Windows
2000 installed, using IEEE 1394 (SCSI print).

ﬂklmportant

O If [Found New Hardware Wizard] appears every time the computer is started or
the cable is connected, disable the device. To install another printer driver af-
ter setting the “1394_00n" port, click [1394_00] as a port during the printer
driver installation.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

O The optional 1394 interface unit can be used only with Service Pack 1 (SP1) or
higher.

ﬂ Connect the machine to the computer using the IEEE 1394 interface cable.
ﬂ Click [Next >] in the [Found New Hardware Wizard] dialog box.

B When the message “This wizard will complete the installation for this De-
vice: Unknown” appears, click [Specify a location], and then click [Next >].

ﬂ When the message “Locate Driver Files” appears, select the [Optional search
locations.] check box, and then click [Specify a location], and then click [Next >].



Installing the Printer Driver Using IEEE 1394 (SCSI print)

B 1nsert the CD-ROM into the CD-ROM drive.
e [f Auto Run starts, click [Cancel], and then [Exit].

e Todisable Auto Run, press the left [ Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

E Click [Browse].

ﬂ Select the printer driver you want to use.

If the CD-ROM drive is D, the source files of the printer driver are stored in

the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\ (Language) \DISK1

e PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

e PCL 5e (for B & W printing)
D:\ADRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN2K_XP\(Language)\DISK1

* PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\ADRIVERS\PS\WIN2K_XP\ (Language) \DISK1

8 Click [Open].
B crick [ok).

m Follow the on-screen instructions.

When installation is complete, the printer connected to “1394_00n" appears
in the [Printers] window: (“n” shows the number of printers connected.)

If the printer driver has already been installed, the printer icon is added to the
[Printers] window. In this case, printer driver installation is not necessary.

If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see Trouble Shooting

& Note

O If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below.

@® When the [Found New Hardware Wizard] dialog box appears, click [Next >].

® When the message “This wizard will complete the installation for this
Device: Unknown” appears, select the [Search for a suitable driver for my
device [recommended]] check box, and then click [Next >].

® When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

@ When the message “Driver Files Search Results” appears, select the [Dis-
able the device. The Add/Remove Hardware Wizard in the control Panel can be

able to complete the driver installations.] check box, and then click [Finish]. 53
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Windows XP, Windows Server 2003

This describes how to install the printer driver to the computer with Windows
XP or Windows Server 2000 installed, using IEEE 1394 (SCSI print).

iﬁklmportant
O SCSI print must be set to “active” from the control panel. For details, see Net-
work Guide.

O Installing this printer driver requires Administrators permission. Log on us-
ing an account that has Administrators permission.

ﬂ Connect the machine to the computer using the IEEE 1394 interface cable.

When the [Found New Hardware Wizard] dialog box appears, check that [This wiz-
ard helps you install software for: (Unknown)] is displayed.

EI Select the [Install from a list on specific location (Advanced)] check box, and then
click [Next >].

8 When the message “Please choose your search and installation option.” ap-
pears, select the [Search for the best driver in these locations.] check box, select
the [Include this location in the search:] check box, and then select the [Include
this location in the search:] check box.

O 1nsert the CD-ROM into the CD-ROM drive.
If Auto Run starts, click [Cancel], and then [Exit].

To disable Auto Run, press the left [Shift] key when inserting the CD-ROM
into the drive and keep it pressed until the computer finishes reading from
the CD-ROM.

B Specify the location where the source files of the printer driver is stored,
and then click [Next >].

If the CD-ROM drive is D, the source files of the printer driver are stored in
the following location:

e RPCS
D:\DRIVERS\RPCS\WIN2K_XP\(Language)\DISK1

¢ PCL 5c (for colour printing)
D:ADRIVERS\PCL5C\WIN2K_XP\(Language)\DISK1

¢ PCL 5e (for B & W printing)
D:ADRIVERS\PCL5E\WIN2K_XP\(Language)\DISK1

e PCL6
D:\DRIVERS\PCL6\WIN2K_XP\(Language) \DISK1

¢ PostScript 3 (“Scanner Driver and Utilities” CD-ROM)
D:\DRIVERS\PS\WIN2K_XP\(Language)\DISK1

When installation is complete, the printer connected to “1394_00n" appears in
the [Printers and Faxes] window. (“n” shows the number of printers connected.)



Installing the Printer Driver Using IEEE 1394 (SCSI print)

E Follow the on-screen instructions.

If the printer driver has already been installed, the printer icon is added to the
[Printers and Faxes] window. In this case, printer driver installation is not nec-
essary.

Even if the printer driver is already installed, the message “Found New Hard-
ware Wizard” may appear when the machine is connected to the computer
using the IEEE 1394 interface cable for the first time. In that case, install the
printer driver.

4 Note

0

0

This machine can receive print data from one computer at a time only. If a
print job from a computer collides with other data, a message may appear
on the computer.

To install another printer driver after setting the “1394_00n" port, click
[1394_00] as a port during the printer driver installation.

When the printer driver is properly installed, connecting or disconnecting
the optional IEEE 1394 cable causes the printer icon to change.

If printing does not work properly after the installation, delete the port and
reinstall the printer driver. For details, see Trouble Shooting.

If you do not want to install the printer when Found New Hardware Wiz-
ard starts under an operating system that supports SCSI print, disable the
device by following the procedure below:

® When the [Found New Hardware Wizard] dialog box appears, check that
[This wizard helps you install software for: Unknown] is displayed, select the
[Install from a list on specific location (Advanced)] check box, and then click
[Next >].

® When the message “Please choose your search and installation option.”
appears, clear all check boxes from [Search for the best driver in these loca-
tions.], and then click [Next >].

® When the message “The wizard could not find the software on your
computer for..” appears, click [OK].

@ When the message “Cannot Install this Hardware” appears, select the
[Don't prompt again to install the software] check box, and then click [Finish].
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Printing with Bluetooth Connection

This describes how to print using with Bluetooth devices.

Supported Profiles

Refer the following supported profiles for Bluetooth connection.

 SPP, HCRP

A maximum of two Bluetooth adaptor or Bluetooth-equipped computers
can be connected at the same time using the Bluetooth interface: one by
SPP, one by HCRP.

When connecting more than one Bluetooth adaptor or Bluetooth-equipped
computer at the same time, the first device that establishes connection is se-
lected. When selecting the connection between the other devices, cancel
the first established connection.

SPP connection does not support bidirectional communications.
HCRP connection supports bidirectional communications.

« BIP

For BIP connection, a module including PostScript 3 must be installed in
the machine.

Only one Bluetooth adaptor or Bluetooth-equipped computer can be con-
nected via BIP.

Only JPEG images that can be printed using BIP.

User codes are disabled for BIP.
You cannot print if print functions are restricted.

Some printers do not support BIP.

4 Note

O In this manual, the instruction referred to print using SPP. To print using
HCRP or BIP, see the Help supplied with the Bluetooth adapter you use.



Printing with Bluetooth Connection

Printing with Bluetooth Connection

To install the printer driver, follow the procedure used to install parallel interface.

ﬁlmportant

O To install the printer driver under Windows 2000 / XP Professional or Win-
dows Server 2003, you must have an account that has Manage Printers per-
mission. Log on as an Administrators or Power Users group member.

ﬂ Start 3Com Bluetooth Connection Manager.

g Check that the printer you want to use appears in 3Com Bluetooth Connec-
tion Manager.

E] on the [Tool] menu, click [COM port].

ﬂ Check that the message “Bluetooth Serial Client (COMXx) “ appears under
Client Ports. (X indicates the COM port number used by Bluetooth.)

B Click [Close].

E On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
B on the [File] menu, click [Properties].
ﬂ Click the [Ports] tab.

mUnder [Port], select the [COMx:] check box. X indicates the COM port
number used by Bluetooth.

m crick fok).
Close the [Printers] window.

& Note

O To always use the same printer, select the [Always use for this connection]
check box.

O System requirements vary depending on the Bluetooth standard and spec-
ifications. For details, see the manuals supplied with each product.

O For information about setting up Bluetooth under other operating systems
or using it with different utilities, see the manuals supplied with those op-
erating systems or utilities.

O If a dialog box appears while transmitting a print job, reestablish network
connection as follows:

@ Select the printer you want to use in the [Printers and Faxes] box.
@ Click [Connect].

p Reference

For details, see the manuals supplied with the Bluetooth adaptor or com-
puter equipped with Bluetooth.
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Configuring Security Mode Settings

This describes how to coufigure the security mode settings.
ﬂ Start 3Com Bluetooth Connection Manager.

H On the [Tools] menu, click [Security Mode].
The [Security Mode] dialog box appears.

B Select the security mode in the [Security Mode:] list.

If you click [High], or [Custom], and specify [Link] in the [Custom Settings] dialog
box, enter the Bluetooth password. For information about entering the pass-
word, see p.58 “Printing in the Security Mode”.

For all other security modes and custom settings, no password is required.
For information about each mode, see the manuals supplied with the utility.

O click fok1.
Close the [Security Mode] dialog box.

A Reference
For details about the security mode, see 3Com Bluetooth Connection Man-
ager Help. For details about the password entry which is required to trans-
mit print jobs, see p.58 “Printing in the Security Mode”.

Printing in the Security Mode

This describes how to print in the security mode.

ﬂ Send the print job to the printer in use.
Depending on the computer configuration, the [Connect] dialog box may ap-
pear. If it does, use it to establish the network connection.

ﬂ The [Authentication] dialog box appears.

B Enter the Bluetooth password, and then click [OK].

As the Bluetooth password, enter the last four digits of the machine's serial
number. You can find the serial number on the label attached to the back of
the machine. For example, if the serial number is 00A0-001234, the Bluetooth
password is 1234.

ﬂ The print job is sent.

& Note
O The Bluetooth password differs for each machine and cannot be changed.



Making Option Settings for the Printer

Making Option Settings for the Printer

Make option settings for the machine using the printer driver when bidirectional
communication is disabled.

/O Reference

For details about making option settings for the printer, see p.61 “If Bidirec-
tional Communication Is Disabled”.

Conditions for Bidirectional Communication

Bidirectional communication allows information about paper size and feed di-
rection settings to be automatically sent to the printer. You can check machine
status from your computer.

* Bidirectional communication is supported by Windows 95 / 98 / Me / 2000
/ XP, Windows Server 2003, and Windows NT 4.0.

¢ If you use the RPCS printer driver and bidirectional communication is ena-
bled under Windows 2000, the [Change Accessories] tab is unavailable.

& Note

O The RPCS printer driver supports bidirectional communications and updates
the machine status automatically.

O The PCL printer driver supports bidirectional communications. You can up-
date the machine status manually.

To support bidirectional communication, the following conditions must be met:

% When connected with parallel cables
* The computer must support bidirectional communication.
¢ The machine must support bidirectional communication.
* The interface cable must support bidirectional communication.

* The machine must be connected to the computer using the standard paral-
lel cables and parallel connectors.

e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.
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% When connected with the network
¢ The machine must support bidirectional communication.

e SmartDeviceMonitor for Client included on the CD-ROM must be in-
m stalled, and TCP/IP must be used.

e Under Windows 2000, [Enable bidirectional support] must be selected, and
[Enable printer pooling] must not be selected on the [Ports] tab with the RPCS
printer driver.

¢ In addition to the above, one of the following conditions must also be met:

* The SmartDeviceMonitor for Client port and the TCP/IP protocol must
be used.

¢ The standard TCP/IP port must be used without changing the default
port name (for Windows 2000 / XP and Windows Server 2003).

* Microsoft TCP/IP print IP address must be specified for use (for Win-
dows NT 4.0).

¢ IPP port name must include the IP address when using the IPP protocol.

< When connected with IEEE 1394

* The computer must support bidirectional communication.

¢ The machine must be connected to the IEEE 1394 connector of a computer
using the IEEE 1394 interface cable.

* [Activate] must be selected in the SCSI print of IEEE 1394 and [Activate] must
be selected in the Bidi-SCSI print.

¢ Under Windows 2000 / XP or Windows Server 2003, [Enable bidirectional
support] must be selected, and [Enable printer pooling] must not be selected
on the [Ports] tab with RPCS printer driver.

< When connected with USB

The machine must be connected to the computer's USB port using the USB in-
terface cable.
The computer must support bidirectional communication.

& Note
O Install SmartDeviceMonitor for Client from the supplied CD-ROM.
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If Bidirectional Communication Is Disabled

Set up option settings when bidirectional communications are disabled.

ﬁlmportant

O Under Windows 2000 / XP and Windows Server 2003, Manage Printers per-
mission is required to change the printer properties in the [Printers] folder.
Log on as an Administrators or Power Users group member.

O Under Windows NT 4.0, Full Control permission is required to change the
printer properties in the [Printers] (Windows 2000) or [Printers and Faxes] (Win-
dows XP / Windows Server 2003) folder. Log on as an Administrators or
Power Users group member.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

When using Windows XP or Windows Server 2003, point to [Settings] on the
[Start] menu, and then click [Printers and Faxes]. The [Printers and Faxes] win-
dow appears.

ﬂ Click the icon of the printer you want to use.
E] On the [File] menu, click [Properties].

ﬂ Click the [Change Accessories] tab.

If options in the [Change Accessories] tab are disabled, bidirectional connection
is enabled. In this case, no change is necessary for option settings.

If you are using the RPCS printer driver, click the [Change Accessories] tab.

B Select options installed from the [Options] area, and then make the neces-
sary settings.

B Select the total amount of the memory in [Total memory:] when the optional
SDRAM module is added.

ﬂ Under [Paper source tray settings:], click and highlight the tray to be used, and
then select the appropriate size, position, and type for the tray. Select the
[Do not use Auto Tray Select] check box to exclude the tray from the targets of
automatic tray selection.

8 Click [OK] to close the printer properties dialog box.
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Installing Font Manager 2000

#¥important

O Under Windows 2000 / XP, Windows Server 2003, or Windows NT 4.0, in-
stalling applications by Auto Run requires administrator permission. To in-
stall a printer driver by Auto Run, log on using an account that has
administrator permission.

ﬂ Quit all applications currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

The installer starts.
B Click [Font Manager 2000].

ﬂ Follow the instructions on the screen.



Using Adobe PageMaker Version 6.0, 6.5, or 7.0

Using Adobe PageMaker Version 6.0, 6.5,
or7.0

Under Windows 95 / 98 / Me / 2000 / XP, Windows Server 2003, or Windows
NT 4.0 with Adobe PageMaker, you need to copy PPD files to the PageMaker
folder.

PPD files have the .ppd extension in the folder “DRIVERS\PS\WIN9X_ME
\(Language)\DISK1” on the CD-ROM.

The “WIN9X_ME” folder inside the “PS” folder is for Windows 95 / 98 / Me.
Use the folder at this level that is appropriate for the operating system you are
currently using.

The third folder “(Language)” may be substituted by an appropriate language
name.

Copy the .ppd file to the PageMaker folder.

¢ For PageMaker 6.0 default installation
The directory is “C:\PM6\RSRC\PPD4".

* For PageMaker 6.5 default installation
The directory is “C:\PM65\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

* For PageMaker 7.0 default installation
The directory is “C:\PM7\RSRC\USENGLISH\PPD4".
The “USENGLISH” may vary depending on your language selection.

& Note
O If the driver is not set correctly after copying the “.ppd” file, printing may not
be performed properly.

O When using PageMaker, the optional features that can be selected by the
printer driver will not be active. The following procedure describes how to
activate the optional printer features.

@® On the [File] menu, click [Print].
The [Print Document] dialog box appears.

® Make the necessary settings in the [Features] box.
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e
2. Setting Up the Printer Driver

PCL - Accessing the Printer Properties

Windows 95 /98 / Me - Accessing the Printer Properties

There are two methods to open the printer properties dialog box.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

ﬁlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

g Click the icon of the printer you want to use.
E) on the [File] menu, click [Properties].
ﬂ Make the necessary settings, and then click [OK].

& Note
O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

/O Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

& on the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.



PCL - Accessing the Printer Properties

Windows 2000 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

iﬁklmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrator and Power Users groups have Manage Printers permission by
default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

E] On the [File] meny, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂklmportant

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

& on the [File] menu, click [Print..].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.
B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.



PCL - Accessing the Printer Properties

Windows XP, Windows Server 2003 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

iﬁklmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

E] On the [File] meny, click [Properties].
The printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Default Settings - Printing Preferences

ﬂklmportant

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help. 69
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Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

& on the [File] menu, click [Print..].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list, and then click
[Preferences].

B Make the necessary settings, and then click [OK] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

p Reference
For details, see the printer driver Help.



PCL - Accessing the Printer Properties

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

ﬁlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.
ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

ﬂ*l mportant
O To change the printer default settings including option configuration settings,

log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

Bl On the [File] menu, click [Document Defauls].
The [Default] dialog box appears.
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ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

& on the [File] menu, click [Print].
The [Print] dialog box appears.

g Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.



RPCS - Accessing the Printer Properties

RPCS - Accessing the Printer Properties

Windows 95 /98 / Me - Accessing the Printer Properties

There are two dialog box types of the printer properties dialog box.

“Multi-tab” is used as an example in this manual. For details about changing the
dialog box types, see the printer driver Help.

% Multi-tab
This dialog box type is designed for users who often change print settings to
perform various printing operations.

% Custom Setting
This dialog box type is designed for users who rarely change print settings.
This type of dialog box may vary depending on the installed options.

Making Printer Default Settings

To make the printer default settings, open the printer properties dialog box from
the [Printers] window.

iﬁklmportant

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

A Reference
For details, see the printer driver Help.
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Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 95 / 98 / Me.

& on the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

B Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

& Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.



RPCS - Accessing the Printer Properties

Windows 2000 - Accessing the Printer Properties

This describes how to launch printer driver's properties.

Making Printer Default Settings - The Printer Properties

ﬁl mportant
O To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows 2000.

B on the [File] menu, click [Print...
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.

B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.



RPCS - Accessing the Printer Properties

Windows XP, Windows Server 2003 - Accessing the Printer
Properties

Making Printer Default Settings - The Printer Properties

ﬁl mportant
O To change the printer default settings including option configuration settings,

log on using an account that has Manage Printers permission. Members of the
Administrators and Power Users groups have Manage Printers permission
by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.
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Making Printer Default Settings - Printing Preferences

ﬂlmportant
O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

l] On the [Start] menu, click [Printers and Faxes].
The [Printers and Faxes] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Printing Preferences...].
The [Printing Preferences] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

A Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the [Printing Preferences]
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows XP.

B on the [File] menu, click [Print...
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Select Printer] list.

B Make the necessary settings, and then click [Apply] to start printing.

& Note

O The procedure to open the [Printing Preferences] dialog box may vary de-
pending on the application. For details, see the manuals provided with the
application you use.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.



RPCS - Accessing the Printer Properties

Windows NT 4.0 - Accessing the Printer Properties

Making Printer Default Settings - The Printer Properties

ﬁlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.

B On the [File] menu, click [Properties].
The printer properties dialog box appears.

When you open the printer properties dialog box initially after installing the
RPCS printer driver, a confirmation message appears. After clicking [OK], the
printer properties dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

/O Reference
For details, see the printer driver Help.

Making Printer Default Settings - Default

ﬁlmportant

O To change the printer default settings including option configuration settings,
log on using an account that has Full Control permission. Members of the Ad-
ministrators, Server Operators, Print Operators, and Power Users groups
have Full Control permission by default.

O You cannot change the printer default settings for each user. Settings made in
the printer properties dialog box are applied to all users.

ﬂ On the [Start] menu, point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use.
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B On the [File] menu, click [Document Defaults...].
The [Default] dialog box appears.

ﬂ Make the necessary settings, and then click [OK].

& Note
O Settings you make here are used as the default settings for all applications.

ye Reference
For details, see the printer driver Help.

Making Printer Settings from an Application

You can make printer settings for a specific application.

To make printer settings for a specific application, open the printer properties
dialog box from that application. The following explains how to make settings
for the WordPad application provided with Windows NT 4.0.

ﬂ On the [File] menu, click [Print].
The [Print] dialog box appears.

ﬂ Select the printer you want to use in the [Name] list, and then click [Properties].
The printer properties dialog box appears.

8 Make the necessary settings, and then click [OK].
ﬂ Click [OK] to start printing.

4 Note

O The procedure to open the printer properties dialog box may vary depend-
ing on the application. For details, see the manuals provided with the ap-
plication you use.

O With some applications, the printer driver settings are not used, and the
application's own default settings are applied.

O Any settings you make in the following procedure are valid for the current
application only.

O General users can change the properties displayed in the [Print] dialog box
of an application. Settings made here are used as defaults when printing
from this application.

A Reference
For details, see the printer driver Help.
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3. Other Print Operations

Printing a PDF File Directly

You can send PDF files directly to the machine for printing, without having to
open a PDF application.

ﬁlmportant
O This function is possible only when the optional PostScript 3 unit is installed.

O This function is possible for genuine Adobe PDF files only.

O Version 1.3, 1.4, and 1.5 PDF files are compatible.

O Transparency and JBIG2 (functions of PDF version 1.4) are not compatible.

O PDF version 1.5 exclusive functions are not compatible.

O Some types of High Compression PDF files are not supported. Consult your
sales representative about the supported file types.

& Note
O Paper size errors may occur when printing on custom size paper.

Printing Method

The following procedures explain the two methods of direct PDF printing - us-
ing DeskTopBinder Lite or by entering commands.

Using DeskTopBinder Lite

Installing DeskTopBinder Lite

Follow the procedure below to install DeskTopBinder Lite.
ﬂ Quit all applications currently running.

Fd 1nsert the CD-ROM into the CD-ROM drive.
The installer starts.

Auto Run may not work under certain operating system settings. In this case,
launch “Setup.exe” located on the CD-ROM root directory.

B Select an interface language, and then click [OK].
ﬂ Click [DeskTopBinder-SmartDeviceMonitor for Client] , and then click [Next >].

B Follow the instructions on the display to install DeskTopBinder Lite.

If you are required to restart the computer after installing DeskTopBinder
Lite, restart the computer and continue the configuration.
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DeskTopBinder Lite Enhancements

Follow the DeskTopBinder Lite enhancement procedure to print PDF files directly.

l] On the [Start] menu, click [Programs], [DeskTopBinder], and [Extended Features
Wizard].

ﬂ When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function3] screen appears.

B On the [Printing Function3] screen, click [Add...] to display [PDF Direct Print Properties].

ﬂ Select Driver for This Machine, click [OK], and then click [Next] repeatedly
until [Finish] is displayed.

Click [Finish].

Function Palette

The Function palette contains buttons for functions that are already configured
through DeskTopBinder Lite enhancement. Using these buttons, you can print
Windows files, preview printouts, convert images, and register scanners for doc-
uments without having to open DeskTopBinder Lite. You can also use these
functions simply by dragging a target file to the button corresponding to the re-
quired function and dropping it there.

I] On the [Start] menu, click [Programs], [DeskTopBinder], and [Function Palette].
An icon for the Function palette is added to the task bar displayed at the bot-
tom right of the screen.

ﬂ Right-click the icon that is added to the task bar, and then click [Properties]
to display the Properties screen.

8 Click the [Contents] tab, select the [PDF Direct Print] check box at the center,
and then click [OK].

The [Properties] screen closes and the [PDF Direct Print] icon is added to the palette.

PDF Direct Printing

Use the method below to print PDF files directly.

ﬂ Drag the PDF file you want to print to the PDF Direct Printing icon in the
palette and drop it there.

B3 [output File List-PDF Direct Print] is displayed.
Highlight the PDF you want to print, and then click [OK].
The PDF file is printed.



Printing a PDF File Directly

Printing PDF Password-Protected Documents

Follow the procedure below to print password-protected PDF files.

l] In the Windows [Start] menu, click [Programs], [DeskTopBinder], and [Extended
Features Wizard].

ﬂ When [Extended Features Wizard] appears, select [Start], and then click [Next]
repeatedly until the [Printing Function3] screen appears.

B On the [Printing Function3] screen, click [Properties...] to display [PDF Direct Print
Properties].

ﬂ Select the [Use PDF Password] check box at the bottom right of the screen, and
then click [OK].

Click [Next] repeatedly until [Finish] appears.
Click [Finish] to close the [Extended Features Wizard] screen.

B Move the PDF file you want to print to the PDF Direct Printing icon on the
palette using a drag-and-drop operation.

[ [output File List-PDF Direct Print] is displayed.
Select the PDF file you want to output to make it reverse video, and then click

[OK].

ﬂ The [PDF Direct Print Properties] screen opens.

Enter the password for the PDF file you want to print in the [PDF Password]
field at the bottom right of the screen, and then click [OK].

The password-protected PDF file is printed.

& Note
O Before printing a password-protected PDF file, perform one of the following;:
* Enter the PDF password in the PDF Direct Printing Properties screen.

* Specify a PDF password by selecting [Change PDF Password] in the [PDF
Menu] on the control panel of this machine
O If a [PDF Group Password] for the [PDF Menu] menu is assigned to either
DeskTopBinder Lite or the control panel of this machine, a same group
password needs to be assigned to the other.
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PDF Direct Print Properties

1. Setting name:

Displays the plug-in configuration name
(up to 63 single byte characters)

2. Change Icon...
Changes the icon displayed on the tool
bar.

3. Printer:

Displays a list of RPCS drivers that sup-
port PDF direct printing.

4. Duplex

Prints on both sides of sheets.

5. Layout
Prints multiple pages on a single sheet.

6. Display this dialog box before
printing

Appears in PDF direct printing mode if
this check box is selected.

7. Orientation:
Specifies the original's orientation.

AMO160S

8. Number of copies
Specifies the number of copies to print.

9. Collate
Sorts printed sheets.

10. Range

Specifies the print area on each page.

11. Color/Black and White:

Specifies color or black-and-white print-
ing.

12. Resolution

Specifies a print resolution.

13. PDF Password

If the PDF file is password-protected, en-
ter the password in this field. Otherwise,
the file cannot be printed.

14. Group Password

If a group password is assigned to Desk-
TopBinder Lite and this machine, enter
the group password in this field. Other-
wise, printing cannot start.

Using commands

You can print PDF files directly, using commands such as “ftp”, “sftp”, and “Ipr”.

p Reference

For details about UNIX commands, see Network Guide.



Unauthorized Copy Control

Unauthorized Copy Control

You can embed patterns and text under printed text to prevent unauthorized
copying of the document. Unauthorized Copy Control consists of two functions:
[Data security for copying] and [Mask type:].

ﬂlmportant

O This function is designed to discourage copying of confidential documents; it
does not prevent unauthorized use of information.

O To use the Unauthorized Copy Control function, configure the RPCS printer
driver settings as shown below. This function cannot be selected if other set-
tings are applied.

¢ In the [Paper type:] list, select [Plain] or [Inkjet Plain Paper].
e If you selected [Plain], select [Quality] on the [Print Quality] tab.
¢ If you selected [Inkjet Plain Paper], select [Normal] on the [Print Quality] tab.

Opening the Unauthorized Copy Control Window

ﬂ In the RPCS printer driver, open the [Printing Preference] window.
EI Click [Add/Change Custom Settings...].
B select the [Unauthorized copy..] check box.

E] Click [Control Settings...].
The Unauthorized Copy Control window appears.

& Note
O For details, see the printer driver Help.
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Using [Data security for copying]

You can embed a pattern by setting it in the printer driver.

[unauthorized Copy Control

ZBwhrenprined
everse pallins, e backaaund
i cony prevention: T
Text
[ T~ Repeat
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el < @ - Fictete 160 dzgress at
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Font sie Angle
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[Certer = e 4
3 Cancel | Help | RestoreDefauts

% Setting [Data security for copying] in the printer driver

e Select the [Data security for copying] checkbox. You can also enter the text in
the [Text:] box.

You cannot select the [Mask type:] checkbox at the same time.

To print a document protected by gray overprint, the machine must be set
up correctly. Consult an administrator.

% Printing a document using [Data security for copying]

1 2 3

)

AJLO30S

1. The pattern and text you have set

3. The document is blanked by gray
is printed.

overprint.
2. The document is copied or stored

in copiers / multifunction machines

which the optional Copy Data Secu-

rity unit is installed.



Unauthorized Copy Control

& Note

O When printing a document that is set with [Data security for copying], the ma-
chine does not require the optional Copy Data Security unit to be installed.
The Copy Data Security unit is required when copying or storing a document
protected by gray overprint.

O Only the RPCS printer driver is supported.

O You cannot partially embed a pattern and text in a document.

[ Use 182 x 257 mm (7!/4 x 10' /2 in.) or larger paper.

O Use ordinary or recycled paper of at least 70% whiteness.

O Duplex printing may interfere with this function as a result of text and pat-
terns being visible through the paper.

A Reference
For details about setting [Data security for copying], see the printer driver Help.
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Using [Mask type:]

You can embed patterns and text in a document by setting in the printer driver
to prevent unauthorized copying.

i
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« Setting [Mask type:] in the printer driver

* Select a pattern from [Mask type:], and then enter text in the [Text:] box.
* You can select overprint colour from [Black], [Cyan], or [Magenta] in the

[Color:] list.
& Note

O You can set only [Text:], but [Mask type:] and [Text:] must be set together.

+ Printing a document using [Mask type:]

2

-

1. The pattern and text you have set

is printed palely.

2. The document is copied, scanned,
or stored in copiers / multifunction

machines.

AJLO31S

3. The pattern and text you have set
appear clearly.



Unauthorized Copy Control

& Note
O Only the RPCS printer driver is supported.

O You cannot partially embed patterns and text strings in a document.

O To make the embedded pattern clear, set the character size at least 50 pt (pref-
erably 70 to 80 pt) and character angle to between 30 and 40 degrees.

O Due to the effects of the settings, the results of copying, scanning, and saving
documents in the document server may vary depending on the machine
model and setting conditions.

O Printing with background patterns and text may be slower than normal printing.

A Reference
For details about setting [Mask type:], see the printer driver Help.

Important Notice

¢ The supplier does not provide warranty regarding the appearance of print
patterns and other copy protection features. The appearance of the print pat-
terns and the performance of Unauthorized Copy Control may vary depend-
ing on the quality of paper used and the machine model and settings.

* The supplier takes no responsibility for any damages sustained in connection
with use of or inability to make use of Unauthorized Copy Control print pat-
terns.
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Using the Print Job Function

This describes how to print files stored in the machine.

Print files stored in the machine can be printed. You can select the print files
from the Job List or User ID screen.

You can print or delete the print jobs saved in the machine which is sent from
computers.

The following types of printing can be selected using the printer driver: Sample
Print, Locked Print, Hold Print, and Stored Print.

Eady

JobReset [Pri.Jobs|  Menu

If you press [Prt.Jobs] on the Printer screen, a screen prompting to select the type
of print job appears. After selecting a type, you can select print files in the list by
pressing:
e [Job List]

Displays the Job List screen.

e [UserID]
Displays the User ID screen.

If you select Sample Print, Locked Print, and Hold Print, the print files saved in
the machine are deleted after printing is completed. If you select Stored Print,
the files remain in the machine even after printing is finished.



Using the Print Job Function

+ Job List

If you press [Job List] when selecting the type of print jobs after [Prt.Jobs] is
pressed in the printer screen, the following screen appears:

1—3tored Print:

/1 s1—2

budzet

3 Smith 08725 11:02 '}3

[
6

1. The type of print jobs
Displays the type of the print job you
select.

2. Page number

Displays the current page number.
Each time pressing [V ] or [A], the
screen switches.

3. User ID, Date / Time, and File
Name display

Displays the time when the instruc-
tion to print the stored files was en-
tered, User ID, and the file names.

4. [Print]

Prints a selected file.

& Note

Delete | Chanze | Print
|

I
5

4

AMO203S

5. [Change]

Changes or deletes the password of a
file if a password is set. To change the
password, press [Change], enter the
current password, and then enter the
new password on the confirmation
screen. To delete the password, press
[Change], leave the entering/confirm-
ing a new password box blank, and
then press the [OK] key.

You can also set passwords to the
Stored Print files that do not currently
have passwords.

. [Delete]

Deletes a selected file.

O When you press [Change] to change or delete a password, you must first
enter the existing password. If the password you entered is incorrect, you
cannot change or delete any current passwords.

O You can use [Change] to set or delete passwords only Stored Print files are

saved in the machine.
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< UserID

If you press [User ID] when selecting the type of print jobs after [Prt.Jobs] is
pressed in the printer screen, the following screen appears:

1—=tared Print: /2  1—»2

I.__:.'_ = 3
Aaa }
Job Li=t | [Printéll

I I
5 4

1. The type of print jobs 3. User ID
Displays the type of the print job you Displays the User IDs who sent files to
select. the machine.

2. Page number 4. [PrintAll]
Displays the current page number. Prints all selected type of files sent by
Each time pressing the [V] or [4] the user ID.

key, the screen switches.

5. [Job List]

Switches the screen to the [Job List]
screen.

& Note
O To cancel selecting a file, press the [ Escape] key.

O The display is not updated if a new file is stored while the list of stored files
is displayed. To update the display, press the [Escape] key to return to the
Printer screen, and then press [Prt.Jobs] again.

O If a large number of print jobs are stored in the machine, processing may slow
temporarily, depending on which functions are used.

A Reference
For details about printing each type of print job, see the followings:

p-93 “Sample Print”
p-97 “Locked Print”
p-101 “Hold Print”

p-104 “Stored Print”



Printing from the Print Job Screen

Printing from the Print Job Screen

This section gives instruction about Sample Print, Locked Print, Hold Print, and
Stored Print.

Sample Print

Use this function to print only the first set of a multiple-set print job. After you
have checked the result, remaining sets can be printed or canceled using the ma-
chine's control panel. This can reduce misprints due to mistakes in content or
settings.

iﬁklmportant
O A Sample Print file cannot be stored if:

¢ the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 9,000 pages in total.
* using the machine with no Function Upgrade Option type C1500 installed.

4 Note

O If a Sample Print file has not been stored properly, check the error log on the
control panel (see p.116 “Checking the Error Log”).

O Even after you turn off the machine, stored documents in the machine re-
main. However, the [Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] set-
tings are applied first (see “Printer Features”, General Settings Guide).

O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Sample Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's [Print] dia-
log box, more prints than intended may be produced.

O If the first set of the Sample Print files is not as you expected and you do not
want to print remaining sets, delete the Sample Print file using the display
panel. If you print the remaining sets of the Sample Print file, the job in the
machine is deleted automatically.

O The files sent to the machine is not saved if you use the machine with no Func-
tion Upgrade Option type C1500 installed.
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Printing a Sample Print File

The following procedure describes how to print a Sample Print file with the PCL
6 / 5c and the RPCS printer driver. For information about how to print a Sample
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement.

ﬂlmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Sample Print in the printer driver's properties.
For details about configuring the printer drivers, see the relevant Help files.

g Start printing from the application's [Print] dialog box.
Make sure to set more than two copies.
The Sample Print job is sent to the machine, and the first set is printed.

B On the machine's control panel, press the [ Printer] key to display the Printer
screen.

O press [Prt.Jobs].

JobRezet [Pri.Jobs| Menu

B Select [Sample Print Jobs] using [ V] or [ 4], and then press [Job List].
BEFrint Jobs 172 =

manple Print Jobs
Locked Print Jobs

Job List | | Uzer ID

A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

You can print files also by pressing [User ID]. For details, see p.108 “Printing
from the User ID Screen”.



Printing from the Print Job Screen

E Select the file you want to print using [ Y] or [4 ], and then press [Print].

Sample Print: 1/6 =
bbb 08728 11:01
doc001. rtf
Delete | | Print

Enter the new number of sets using the number keys. You can enter up to 999
sets.

Press [ Clear/Stop] to correct any entry mistakes.

U press [print].
The remaining sets are printed.
Press [Cancel] to cancel printing.

& Note
O When printing is completed, the stored file will be deleted.

O To stop printing after printing has started, press the [ Escape ] key until the
Printer screen appears, and then press [JobReset]. The file will be deleted.

95




Other Print Operations

Deleting Sample Print Files

If you are not satisfied with the sample printout, you can delete the Sample Print
file, revise it and print it again until the settings are suitable.

0 press the [ Printer] key to display the Printer screen.
F press [Prt.Jobs].

JobReset [Pri.Jobs|  Menu

B Select [Sample Print Jobs] using [ V] or [ 4], and then press [Job List].
BEFrint Jobs 142 =

samnple Print Jobs
Locked Print Jobs

Job List | | Uzer ID

A list of Sample Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete using [ Y] or [4 ], and then press [Delete].

sample Print: 146 ¥
bbb 0825 11:01
doc001. rtf
Delete | [ Print

The delete confirmation screen will appear.

B press [Delete] to delete the file.
The selected file is deleted.

& Note
O If you do not want to delete the file, press [Cancel].
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Locked Print

Use this function to maintain privacy when printing confidential documents on
the machine over a shared network. Usually, it is possible to print data using the
display panel once it is stored in this machine. When using Locked Print, it is not
possible to print unless a password is entered on the machine's display panel.
Your confidential documents will be safe from being viewed by other people.

ﬂklmportant
O A Locked Print file cannot be stored if:

* the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 9,000 pages in total.
* using the machine with no Function Upgrade Option type C1500 installed.

& Note

O If a Locked Print file has not been stored properly, check the error log on the
control panel (see p.116 “Checking the Error Log”).

O Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied first
(see “Printer Features”, General Settings Guide).

O If the application has a collate option, make sure it is not selected before send-
ing a print job. Locked Print jobs are automatically collated by the printer
driver as default. If a collate option is selected in the application print dialog
box, more sets than intended may be printed.

O After the Locked Print file is printed, the job is automatically deleted.

O The files sent to the machine is not saved if you use the machine with no Func-
tion Upgrade Option type C1500 installed.

97



98

Other Print Operations

Printing a Locked Print File

The following procedure describes how to print a Locked Print file with the PCL
6 / 5c and the RPCS printer driver. For information about how to print a Locked
Print file with the PostScript 3 printer driver, see PostScript 3 Supplement.

ﬂlmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure the Locked Print in the printer driver's properties.

For details about configuring the printer drivers, see the corresponding Help
files.

ﬂ Start printing from the application's [Print] dialog box.
The Locked Print job is sent to the machine.

B on the machine's control panel, press the [ Printer] key to display the Printer
screen.

ﬂ Press [Prt.Jobs].

JobRezet [Pri.Jobs| Menu

A list of print files stored in the machine appears.

B Select [Locked Print Jobs] using [ V] or [4 ], and then press [Job List].

BEFrint Jobs 1/2 =

sample Print Jobs
Locked Print Jobs

Job List | | User ID

A list of Locked Print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

You can print files also by pressing [User ID]. For details, see p.108 “Printing
from the User ID Screen”.



Printing from the Print Job Screen

E Select the file you want to print using [ Y] or [4 ], and then press [Print].

Locked Print: 174 =
3 Emith 08728 11:01
bR R
Delete | Change | Print

The password screen appears.

ﬂ Enter the password using the number keys, and then press the [ OK] key.

Enter the password
then press OK.

The print confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly.
Press [EXit] to enter the password again.

If you forget your password, ask your network administrator for help.

8 Press [Print].
The locked file is printed.
Press [Cancel] to cancel printing.
& Note
O When printing is completed, the stored file will be deleted.

3 To stop printing after printing has started, press the [ Escape ] key until the
Printer screen appears, and then press [JobReset]. The file will be deleted.
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Deleting Locked Print Files

0 press the [ Printer] key to display the Printer screen.
F press [Prt.Jobs].

Eady

JobReset [Pri.Jobs|  Menu

B Select [Locked Print Jobs] using [ Y] or [4 ], and then press [Job List].
BEFrint Jobs 142 =

sample Print Jobs
Locked Print Jobs

Job List | | Uzer ID

A list of Locked Print files stored appears.

Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete using [ Y] or [4 ], and then press [Delete].

Locked Print: /4 &

3 =mith 08725 11:01
R

Delete | Change | Print

The password screen is displayed.

B enter the password using the number keys, and then press the [ 0K] key.

Enter the password
then press OK.

The delete confirmation screen appears.

A confirmation screen will appear if the password is not entered correctly.
Press [EXit] to enter the password again.

If you forget your password, ask your network administrator for help.

B Press [Delete].
The selected file is deleted.
If you do not want to delete the file, press [Cancel].
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Hold Print

Use this function to temporarily hold a file in the machine, and print it from the
computer or the machine's control panel later.

iﬁklmportant
O A Hold Print file cannot be stored if:

¢ the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 9,000 pages in total.
* using the machine with no Function Upgrade Option type C1500 installed.

4 Note

O If a Hold Print file has not been stored properly, check the error log on the
control panel (see p.116 “Checking the Error Log”).

O Even after you turn off the machine, stored documents in the machine re-
main. However, the [Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] set-
tings are applied first (see “Printer Features”, General Settings Guide).

O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Hold Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

O The files sent to the machine is not saved if you use the machine with no Func-
tion Upgrade Option type C1500 installed.

Printing a Hold Print File

The following procedure describes how to print a Hold Print file with the PCL 6
/ 5c and the RPCS printer driver. For information about how to print a Hold
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement.

ﬂklmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Hold Print in the printer driver’s properties.
For details about configuring the printer drivers, see the relevant Help files.

ﬂ Click [Details...], and then enter a User ID in the [User ID:] box.

You can also set a file name. The file name you set will be displayed on the
machine's Job List screen.
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B Start printing from the application’s [Print] dialog box.
The Hold Print job is sent to the machine and stored.

O on the machine’s control panel, press the [Printer] key to display the print-
er screen.

B press [Prt.Jobs].

Readsy

JobReset [Pri.Jobs|  Menu

E Select [Hold Print Jobs] using [ V] or [ 4 ], and then press [Job List].

BFrint Jobs 20 ¥
Hold Print Jobs
stored Print Jobs

Job List | [ Uzer ID

A list of a print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

You can print files also by pressing [User ID]. For details, see p.108 “Printing
from the User ID Screen”.

ﬂ Select the file you want to print using [ V] or [4 ], and then press [Print].

Hold Print: 172 =
bbb 08726 11200
schedule
Delete | | Print

The confirmation screen appears.

8 Press [Print].
The Hold Print file is printed.
Press [Cancel] to cancel printing.

& Note
O When printing is completed, the stored file is deleted.

O To stop printing after printing has started, press the [ Escape] key until the
Printer screen appears, and then press [JobReset]. The file is deleted.

A Reference
For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Hold Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.



Printing from the Print Job Screen

Deleting Hold Print Files

0 press the [ Printer] key to display the Printer screen.
F press [Prt.Jobs].

Eady

JobReset [Pri.Jobs|  Menu

B Select [Hold Print Jobs] using [ V] or [ 4 ], and then press [Job List].
BEFrint Jobs 2w

Hold Print Jobs
stored Print Jobs

Job List | | Uzer ID

A list of a Hold Print files stored in the machine appears.
Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete using [ Y] or [4 ], and then press [Delete].

Hold Print: 172 =
bbb 08726 11200
schedule
Delete | | Print

The delete confirmation screen will appear.

B press [Delete] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [Cancel].
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Stored Print

Use this function to store a file in the machine, and then print it from the com-
puter or the machine's control panel later.

Jobs are not deleted after they are printed, so the same job need not be resent in
order to print multiple copies.

iﬁklmportant
O A Stored Print file cannot be stored if:

* the total number of Sample Print, Locked Print, Hold Print, and Stored
Print files in the machine is over 100. (The maximum number varies de-
pending on the volume of data in files.)

¢ the file contains over 1,000 pages.
* sent or stored files in the machine contain over 9,000 pages in total.
* using the machine with no Function Upgrade Option type C1500 installed.

4 Note

O If a Stored Print file has not been stored properly, check the error log on the
control panel (see p.116 “Checking the Error Log”).

O Even after you turn off the machine, stored documents remain. However, the
[Auto Delete Temporary Jobs] or [Auto Delete Stored Jobs] settings are applied first
(see “Printer Features”, General Settings Guide).

O If the application has a collate option, make sure it is not selected before send-
ing a print job. By default, Stored Print jobs are automatically collated by the
printer driver. If a collate option is selected from the application's Print dialog
box, more prints than intended may be produced.

O The files sent to the machine is not saved if you use the machine with no Func-
tion Upgrade Option type C1500 installed.



Printing from the Print Job Screen

Printing a Stored Print File

The following procedure describes how to print a Stored Print file with the PCL
6 / 5c and the RPCS printer driver. For information about how to print a Stored
Print file with the PostScript 3 printer driver, see Postscript 3 Supplement in-
cluded.

iﬁklmportant
O Applications with their own drivers, such as PageMaker, do not support this
function.

O If you are using Mac OS X, you need Mac OS X v10.2 or higher to use this
function.

ﬂ Configure Stored Print in the printer driver’s properties.
You can select two ways for Stored Print:

e [Stored Print]
Stores the file in the printer and print it later using the control panel.

e [Store and Normal Print]
Prints the file at once and also stores the file in the printer.

For details about configuring the printer drivers, see the relevant Help files.

g Click [Details...], and then enter a User ID in the [User ID:] box.

You can also set a password. The same password must be entered when print-
ing or deleting.

You can set a file name. The file name you set will be displayed on the ma-
chine's Job List screen.

B Start printing from the application’s [Print] dialog box.
The Stored Print job is sent to the machine and stored.

ﬂ On the machine’s control panel, press the [Printer] key to display the print-
er screen.

B press [Prt.Jobs].

JobRezet [Pri.Jobs| Menu
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E Select [Stored Print Jobs] using [ V] or [A ], and then press [Job List].

BEFrint Jobs 2/ =
Hold Print Jobs
atored Print Jobs

Job List | | Uzer ID

A list of Stored Print files stored in the machine appears.

You can print files also by pressing [User ID]. For details, see p.108 “Printing
from the User ID Screen”.

ﬂ Select the file you want to print using [ V] or [4 ], and then press [Print].

stored Print: TS
aaa 0810 11:15

meet ing

Delete | Change | Print

The confirmation screen appears.

If you set a password in the printer driver, a password confirmation screen
appears. Enter the password.

Enter the number of sets using the number keys.

8 Press [Print].

The Stored Print file is printed.
Press [Cancel] to cancel printing.

@ Note

O3 To stop printing after printing has started, press the [ Escape ] key until the
Printer screen appears, and then press [JobReset]. A Stored Print file is not
deleted even if [JobReset] is pressed.

O The Stored Print file that sent to the machine is not deleted unless you de-
lete a file or select [Auto Delete Stored Jobs] (see “Printer Features”, General
Settings Guide). For details, see p.107 “Deleting Stored Print Files”.

O You can set or delete a password after sending files to the machine. Select
the file and press [Change] in the Print Job List screen. To set a password,
enter the new password. To delete the password, leave the password box
blank on entering or confirming the new password, and press the [OK]
key.

p Reference

For details about setting printer drivers, see the printer driver Help. You
can also print or delete a Stored Print file from Web Image Monitor. For de-
tails, see Web Image Monitor Help.



Printing from the Print Job Screen

Deleting Stored Print Files

0 press the [ Printer] key to display the Printer screen.
F press [Prt.Jobs].

Eady

JobReset [Pri.Jobs|  Menu

B Select [Stored Print Jobs] using [ V] or [A ], and then press [Job List].

BEFrint Jobs 2/ =
Hold Print Jobs
atored Print Jobs

Job List | | Uzer ID

A list of Stored Print files stored in the machine appears.

Depending on the security settings, certain print jobs may not be displayed.

ﬂ Select the file you want to delete using [ Y] or [4 ], and then press [Delete].

Stored Print: BfE =
Aaa 08410 11215
meet ing
Delete | Change | Print

The delete confirmation screen will appear.
If you set the password in the printer driver, enter the password to delete.
If you forget your password, ask your network administrator for help.

B Press [Delete] to delete the file.
The selected file is deleted.
If you do not want to delete the file, press [Cancel].
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Printing from the User ID Screen

This describes how to print the files saved in the machine from the User ID screen.

Printing the Selected Print Job

ﬂ On the Printer screen, press [Prt.Jobs].

JobReset [Pri.Jobs|  Menu

Bl select a type of print jobs you want to print using [¥] or [4], and then
press [User ID].

BFrint Jobs 172 =

manple Print Jobs
Locked Print Jobs

Job List | | Uzer ID

A list of user IDs whose files are stored in the machine appears.

8 Select the user ID whose file you want to print using [V ] or [4 ], and then
press [Job List].

stored Print: 1/2 =

daa

Job List | [Frintill

The print job list of the selected user ID appears.

O select the file you want to print using [ V] or [4 ], and then press [Print].

Stored Print: 171 =
3 Emith 08/26 11:02
budget

Delete | Change | Print

The confirmation screen appears.




Printing from the User ID Screen

B press [print].
The selected file is printed.
To cancel printing, press [Cancel].

A Reference
For details about printing each type of print job, see the followings:

p-93 “Sample Print”
p-97 “Locked Print”
p-101 “Hold Print”

p-104 “Stored Print”

Printing All Print Jobs

ﬂ On the Printer screen, press [Prt.Jobs].

JobReset [Pri.Jobs|  Menu

Bl select a type of print jobs you want to print using [Y] or [4], and then
press [User ID].

BFrint Jobs 172 =

manple Print Jobs
Locked Print Jobs

Job List | | Uzer ID

A list of user IDs whose files are stored in the machine appears.

B Select the user ID whose file you want to print using [V ] or [4 ], and then
press [PrintAll].

Stored Print: 1/2 =

daa

Job List | Primtéll

The confirmation screen appears.

ﬂ Press [Print].
The selected files are printed.
To cancel printing, press [Cancel].
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& Note
O After printing is completed, Sample Print, Locked Print, and Hold Print

files are deleted.

O You cannot select a print job that is not stored under the selected user ID.
O If you select multiple Sample Print files and do not specify the number of

sets on the confirmation screen, one set less than the number specified on
the computer is printed for every selected document. If the number of sets
specified on the computer is “1”, one set each is printed for every docu-
ment.

When printing multiple Stored Print files, and do not specify the number
of sets on the confirmation screen, the minimum number of set quantity
among all settings is applied.

When the number of set quantity is changed, the changed quantity is ap-
plied to all selected print files.

If you select Locked Print, enter the correct password. If there are multiple
passwords, the machine prints only files that correspond to the entered
password.

If you select Stored Print files, and some of these require a password, the
machine prints files that correspond to the entered password and files that
do not require a password.

/O Reference

For details about printing each type of print job, see the followings:
p-93 “Sample Print”

p-97 “Locked Print”

p-101 “Hold Print”

p-104 “Stored Print”



Form Feed

Form Feed

This section gives instructions for operating the machine when there is no tray for
the selected paper size or type, or when paper loaded in the machine has run out.

ﬂklmportant
O The tray cannot be changed if the following functions are set:

¢ Duplex Print to a tray that does not support duplex printing
¢ Selecting the One Sheet bypass tray

& Note

O If form feed is selected for a tray with the following settings, you can change
the tray by canceling the settings:

* Duplex Print

O If Auto Continue is selected, form fed paper is printed after a set interval. See
“Printer Features”, General Settings Guide.

Printing from a Selected Tray

If the machine does not have a tray for the selected paper size or paper type, or
if the selected paper loaded in the machine has run out, a caution message ap-
pears. If this message appears, do the following procedure.

ﬂ When the caution message appears, press [FormFeed].

Chanze Tray 1 to the
following =zettinzs:
DuxgsCI (1) Plain)

JobReszet |FormFeed

ﬂ On the confirmation screen, press [ OK].

FormFeed the fol lowing:
7

ﬁncument.rtf
[ Cancel | 0K

If you want to stop printing, press [Cancel].
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B Select the tray for form feed using [ V] or [ 4 ] from those that appear on the
display panel, and then press the [ OK] key.

If you want to print after adding paper to the tray, select the tray after loading
the correct paper.

select Traw 142 ¥[0K]
i = Y
L

The machine prints using the selected tray.

& Note
O If a tray with a smaller paper size is selected, the print job may be cut short,
or other problems may occur.
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Canceling a Print Job

Follow this procedure for canceling the print job if the message prompting form
feed appears.

ﬂ Press [JobReset].

Change Tray 1 to the
fol lowing szettings:
Cug¥301J Plain)

[ JobRezet |FormFesd

8 Press [Current].

Reset the following job:
bbb
doc001, rtf

[ Current | Resume

The confirmation message appears.
To resume printing jobs, press [Resume].

8 Press [Yes] to cancel the print job.

Reset the current job?
bbb
doc001, rtf

[ HWo [ Yes

Press [No] to return to the previous display.

& Note
O If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

O Under Windows, If the machine is connected to the computer using a par-
allel cable, sent print jobs may be canceled if [JobReset] is pressed while
“Waiting...” is displayed on the control panel. After the interval set in [I/O
Timeout] in Printer Features has passed, the next print job can be sent. A print
job sent from a different client computer will not be canceled in this case.

O You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].

O A print job containing a large volume of data may take considerable time
to stop.

A Reference
For details, see p.114 “Canceling a Print Job”.
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Canceling a Print Job

This section gives instruction to stop printing from the computer or the control
panel.

Canceling a Print Job Using the Control Panel

ﬂ Press [JobReset] on the display panel or the [ Clear/Stop] key on the control
panel.

A confirmation message appears.

ﬂ Press [Current].

Reset the following job:
bbb
doc001, rtf

[ Current | Resume

To resume printing jobs, press [Resume].

B Press [Yes] to cancel the print job.

Reset the current job?
bbb
docl01, rtf

[ No [ ‘es

Press [No] to return to the previous display.
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Windows - Canceling a Print Job from the computer

You can cancel a print job from the computer if transferring print jobs is not com-
pleted.

ﬂ Double-click the printer icon on the Windows task tray.

A window appears, showing all print jobs currently queued for printing.
Check the current status of the job you want to cancel.

ﬂ Select the name of the job you want to cancel.

El On the [Document] menu, click [Cancel Printing].

O press the [ Printer] key on the machine's control panel.

& Note

0

0

If the machine is shared by multiple computers, be careful not to acciden-
tally cancel someone else's print job.

If the machine is connected to the computer using a parallel cable, sent
print jobs may be canceled if [JobReset] is pressed while “Waiting...” is dis-
played on the control panel. After the interval set in [I/O Timeout] in Printer
Features has passed, the next print job can be sent. A print job sent from a
different client computer will not be canceled in this case.

In Windows XP, Windows Server 2003, and Windows NT 4.0, click [Cancel]
on the [Document] menu.

In Windows 95 / 98 / Me / 2000 or Windows NT 4.0, you can also open
the print job queue window by double-clicking the machine icon in the
[Printers] machine window (the [Printers and Faxes] window under Win-
dows XP and Windows Server 2003).

You cannot stop printing data that has already been processed. For this
reason, printing may continue for a few pages after you press [JobReset].
A print job containing a large volume of data may take considerable time
to stop.
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Checking the Error Log

If files could not be stored due to printing errors, identify the cause of the errors
by checking the error log on the control panel.

iﬁklmportant

O The most recent 30 errors are stored in the error log. If a new error is added
when there are 30 errors already stored, the oldest error is deleted. However,
if the oldest error belongs to one of the following print jobs, it is not deleted.
The error is stored separately until the number of those errors reaches 30. You
can check any of these print jobs for error log information.

¢ Sample Print
¢ Locked Print
¢ Hold Print
¢ Stored Print
O If the main power switch is turned off, the log is deleted.

ﬂ Press the [ Printer] key to display the Printer screen.
ﬂ Press [Menu].

JobRezet [Pri.Jobs| Menu

B Select [Show Error Log] using [ V] or [ A ], and then press the [ OK] key.

Oselecta type of print jobs using [ V] or [4 ], and then press the [OK] key.
If you select [All], all error logs appears.

Show Error Log 1/2 =[0K]|
i | |

sample Print Jobs
Locked Print Jobs

B Select the error log you want to check using [V] or [4].

Error Log:dl| 1/13 =
16 aaa 087256 11:35
budzet plan
MPrint Data Error

A detailed error log appears.

& Note
O Press the [ Escape ] key until the Printer screen appears after checking the log.

O To print files that appear in the error log, resend them after stored files
have been printed or deleted.



Spool Printing

Spool Printing

Spool Printing allows print jobs transferred from a computer to be temporarily
stored, and then prints them after they are transferred. This shortens printing
time as it maximizes printer efficiency.

ﬂlmportant

O During Spool Printing, the hard disk is accessed and the Data In indicator
blinks. Turning off the computer or machine during Spool Printing can dam-
age the hard disk. Also, if the computer or machine is turned off during Spool
Printing, spooled jobs will be deleted. Therefore, do not turn the power to the
computer or machine off during Spool Printing.

O If data is sent to the machine using other protocols besides diprint, lpr, ipp,
smb (TCP/IP (IPv6)), and sftp, Spool Printing cannot be performed.

O Up to a maximum of 150 jobs at once can be spool printed.

O This function is available only on machines that have Function Upgrade Op-
tion type C1500 installed.

+ Setting Spool Printing
Spool Printing can be set using telnet or Web Image Monitor.

¢ Using Web Image Monitor
See Network Guide or Help for more information.

¢ Using telnet
Type in “spoolsw spool on” to set Spool Printing.
See Network Guide for more information about telnet.

% Viewing/Deleting spool jobs in Web Image Monitor
Start Web Image Monitor and enter the machine's IP address in the address
bar. This displays the top page.
For more information, see Network Guide.

& Note
O Printing the first page with Spool Printing will be slow.

O The computer requires less print processing time when large amounts of data
are spooled.

O Stored spool jobs can be viewed or deleted using Web Image Monitor.
O The list of spool jobs cannot be viewed from the machine's control panel.
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Collate

When printing multiple documents such as handouts for meetings, you can sep-
arate sets into order. This function is known as “Collate”. Collate stores data trans-
mitted from a computer in memory. The following are the two types of collate:

ﬂlmportant
O Rotating Collate is not possible when feeding paper from the bypass tray and

the One Sheet bypass tray.
O If jobs containing pages of various sizes are set, Rotating Collate will not work.

O If Function Upgrade Option type C1500 is not installed, this function cannot
be used.

< Collate
Printed output is assembled as sets in sequential order.

12 12 12 12

% Rotating collate
Every other print set is rotated by 90 degrees [J.

Ll

AEU016S

AEU017S



Collate

& Note

0

0

You can set Collate in the RPCS printer driver.
If Auto Continue occurs on the first set, Collate will be canceled.
If forced printing occurs on the first set, Collate will be canceled.

If a document with mixed paper sizes or sizes larger than A4, 81/, x 11 is set,
it can only be collated, even if Rotating Collate has been selected.

When Rotating Collate has been selected, printing speed will be slower than
with other collate functions.

When setting Collate in the printer driver settings, make sure that a collate
option is not selected in the application's print settings. If a collate option is
selected, printing will not be as intended.

The Rotating Collate function requires two paper trays containing same size
paper but in different orientations.

/O Reference

For information about paper sizes and the number of sets you can use Collate
or Rotating Collate with in every option, see Copy Reference.

For printing methods, see the printer driver Help.
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e
4. Direct Printing from a Digital

Camera (PictBridge)

What is PictBridge?

You can connect a PictBridge-compatible digital camera to this machine using a
USB cable. This allows you to print photographs taken using the digital camera
directly by operating the digital camera.

————

AMTO014S

Before you can use this function, the machine requires the following options:
* USB host interface board
¢ Camera direct print card

& Note
O Check your digital camera is PictBridge-compatible.

O Up to 999 images can be sent from the digital camera to the machine during
one print transaction. If an attempt is made to send more images, an error
message is sent to the camera and printing fails.

O Since printing conditions are specified on the digital camera, specifiable pa-
rameters depend on the particular digital camera. For details, see your digital
camera's manual.

O This function is compatible with USB 1.1.

O If Function Upgrade Option type C1500 is not installed, this function cannot
be used.
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PictBridge Printing

Follow the procedure below to start PictBridge printing on this machine.

iﬁklmportant

O Do not disconnect the USB cable while data is being sent. If you do, printing
will fail.

O The USB host interface board is supplied with a USB cable and a hook onto
which you can roll up and hang the cable.

B Attach the hook on the back of the machine near the USB connection slot.
Attach the hook where it will not interfere with machine operation and access.

ﬂ Check the machine and the digital camera are both switched on.
B Connect a USB cable between the optional USB host interface board in-

stalled on the machine and the digital camera.

The Data In indicator on the machine blinks for several seconds and “Pct-
Brdg” is displayed on the machine. This indicates the machine recognizes the
digital camera as a PictBridge device.
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AMO100S

ﬂ Secure the USB cable using the hook.
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B On your digital camera, select the images you want to print, and specify the
printing conditions.
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O the machine receives settings from the digital camera and starts printing.

& Note

O Since printing conditions are specified on the digital camera, specifiable
parameters depend on the particular digital camera. For details, see the
digital camera's manual.

O Some digital cameras require settings for manual PictBridge operation. For
details, see your digital camera's manual.

A Reference
To stop data printing, see p.114 “Canceling a Print Job”.
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What Can Be Done on This Machine

This machine can perform the following functions using its PictBridge feature.
The settings available for these functions are as follows:
* Single image printing

¢ Selected image printing

¢ All image printing

* Index printing

¢ Trimming

* Date and file name printing

* DPaper size

* Image print size

¢ Multi-Image-Layout

* Printing quality

¢ Color matching

* Paper type specification

¢ Form printing

¢ Camera memo printing

& Note
O This machine does not support the following settings:

¢ DPOF printing
* Margin-less printing

O The setting parameters and their names may vary depending on the digital
camera. For details, see your digital camera's manual.
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Index Printing

< A3 (297 x 420)

Horizontal images x vertical images (in) Paper orientation
12x 16 E
16 x 12 =

< A4 (210 x 497)

Horizontal images x vertical images (in) Paper orientation
8x12 E
12x 8 g
< A5 (148 x 210)
Horizontal images x vertical images (in) Paper orientation
5x8 K
8x5 [y

% Letter (8'/> x 11)

Horizontal images x vertical images (in) Paper orientation
8x 10 E
10x 8 =

< B4 (257 x 367)

Horizontal images x vertical images (in) Paper orientation
10 x 14 E
14 x 10 =
& Note

O Index printouts vary depending on the orientation of the paper placed on the
specified size tray.

O Depending on the digital camera, a form feed may be inserted after one set of
images belonging to one type ends.

O The number of images in each size of paper is fixed.
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Trimming

Use this function to print only the inside of the trimming area specified on the
digital camera.

AGZ007S

1 - Trimming area

Date and File Name Printing

Use this function to print the date and/or file name under the image.

A

aaaaaa
bbbbbb

AGZ005S

In the above figure, “aaaaa” indicates the file name and “bbbbb” indicates the date.
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Paper Size
Use this function to print on paper with the size specified on the digital camera.
Paper size name Actual size
2L (5" x77) 178 mm x 127 mm (5 in. x 7 in.)
Postcard 148 mm x 100 mm
100 mm x 150 mm 150 mm x 100 mm
47 x 6" 152.4 mm x 101.6 mm (4 in. x 6 in.)
8”7 x 10” 254 mm x 203.2 mm (8 in. x 10 in.)
Letter (8 1/, x 117) 279.4 mm x 216 mm (8 1/, x 11)
117 x 17”7 431.8 mm x 279.4 mm (11 in. x 17 in.)
A3 420 mm x 297 mm
A4 297 mm x 210 mm
A5 210 mm x 148 mm
A6 148 mm x 105 mm
B4 364 mm x 257 mm
B5 257 mm x 182 mm
B6 182 mm x 128 mm

& Note
O Specify Undefined Size for the 2L (5” x 7”), 100 mm x 150 mm, 4” x 6", 8” x
10”7, A6, B5, and B6 sizes.

O For details about specifying undefined sizes, see p.12 “Setting Custom Size
Paper”.
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Image Print Size

Use this function to print images with the size specified on the digital camera.

m AGZ008S

-- indicates the image size specified on the camera.

You can specify the following image print sizes:

% Fixed size
e 3257 x25"
e 5" x25”
e 6" x4”
e 7" x5”
e 10" x8”
e 254 mm x 178 mm
e 110 mm x 74 mm
e 89 mm x 55 mm
e 148 mm x 100 mm
e 8cm x 6 cm
e 10cm x7cm
¢ 13cm x9cm
e 15cm x 10 cm
e 18cm x 13 cm
e 2l cm x 15 cm
e 24 cmx 18 cm

& Note
O An error occurs if the specified size is larger than the actual paper size.
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What Can Be Done on This Machine

Multi-Image-Layout

Use this function to print multiple images on the specified paper.

\j

A

AGZ002S

The number of images that can be printed on one page is as follows:

Paper size Number of images that can be specified
2L (5" x77) 2,4,8,9
Postcard 2,4
100 mm x 150 mm 2,4
4” x 6" 2,4,8,9
8” x10” 2,4,8,9,16,25,32

Letter (8/2” x 117)

2,4,8,9,16, 25,32

117 x 17”7 2,4,8,9,16,25,32,49, 64
A3 2,4,8,9,16,25,32,49, 64
A4 2,4,8,9,16,25,32

A5 2,4,8,9,16

A6 2,4,8

B4 2,4,8,9,16,25,32,49

B5 2,4,8,9,16,25

B6 2,4,8,9
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The number and arrangement of images that can be specified are as follows:

Number of images Vertical images x horizontal Paper orientation
images
2 2x1 E
4 2x2 =
8 4x2 L
9 3x3 [
16 4x4 =
25 5x5 =
32 8x4 E
36 6x6 =
49 7x7 =
64 8x8 =
& Note
O A form feed may be inserted between images depending on the digital cam-
era in use.

O Printing in the specified way may not be possible depending on the specifica-
tion for the number of images to be printed.

Printing Quality

Use this function to print images at the selected printing quality.

If you select [Default] or [Normal], the machine prints in normal quality; if you se-
lect [Fine], the machine prints in the best quality.

Color Matching

Use this function to optimize colors when printing images.

If you select [Default] or [OFF], the machine prioritizes gradation for color match-
ing, if you select [ON], the machine prioritizes saturation.
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What Can Be Done on This Machine

Paper type Specification

This function sends the machine's paper type information to the digital camera.
The names of paper types displayed on the digital camera's screen are different
to the names displayed on the machine. Use the table below to match the paper

types.
To display a paper type name on the digital camera's screen, use the machine's
control panel to set the paper type of the machine correctly.

The paper type detected by the digital cam- The paper type of the machine
era

Default All type of paper

Plain Paper Plain or recycled paper

Photo Paper Inkjet plain paper, Inkjet postcards

Form Printing

Use this function to print images in a predetermined layout format.

AGZ009S

Camera Memo Printing

Use this function to print text data together with an image if it is attached to the
image.
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Exiting PictBridge

Follow the procedure below to quit the PictBridge mode.

iﬁklmportant
O Do not disconnect the USB cable while data is being sent to the machine. If
you do, printing will fail.

ﬂ Check the control panel of this machine is displaying the “Ready” state.

ﬂ Disconnect the USB cable from the machine.

132



Other Reference Information

Other Reference Information

For further details about printing on this machine, see the following;:

/O Reference

Fore details about paper size, paper type, or tray settings, see General Settings
Guide.
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5. The Functions and Settings

of the Machine

Mainframe

Network Guide, PostScript 3 Supplement, and UNIX Supplement cover all mod-
els, and therefore contain all the functions and settings. This chapter describes
the functions and setting items used for configuring the model you are using.

p Reference

For details about functions and setting items, see Network Guide, PostScript
3 Supplement and UNIX Supplement.

Functions

The following functions are available with the machine:
* Copy

¢ Printer

e Scanner

e Fax

4 Note

O The machine must be equipped with the Printer /Scanner Unit in order to use
the printer or scanner function.

Interface

The following interfaces are available with the machine:
¢ Ethernet (100BASE-TX / 10BASE-T)

e USB (2.0)

e USB Host (1.1) (Optional)

» IEEE 1284 (Parallel) (Optional)

e JEEE 1394 (Optional)

e JEEE 802.11b (Wireless LAN) (Optional)

¢ Bluetooth (Optional)

& Note

O To use the IEEE 1284, IEEE 1394, IEEE 802.11b (wireless LAN), or Bluetooth
interface, the machine must be equipped with the corresponding unit for that
interface.

3 You cannot have the IEEE 1284, IEEE 1394, IEEE 802.11b (wireless LAN), and
Bluetooth interface on the machine at the same time.
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List of the Setting ltems

Web Image Monitor

The following tables show Web Image Monitor items that can be viewed or mod-
ified depending on the selected mode on the Web browser.

Select one of the following modes to log on Web Image Monitor:
¢ User mode: log on as a user
* Administrator mode: log on as an administrator

< Home
e Status
Menu User mode Administrator mode
Ink Read Read
Input Tray Read Read
Output Tray Read Read
* Configuration
Menu User mode Administrator mode
Function Read Read
System Read Read
Version Read Read
Printer Language Read Read
e Counter
Menu User mode Administrator mode
Copier Read Read
Printer Read Read
Fax Read Read
Send/TX Total Read Read
Fax Transmission Read Read
Scanner Send Read Read
Other Function(s) Read Read
¢ Inquiry
Menu User mode Administrator mode
Machine Maintenance/Re- | Read Read
pair
Sales Representative Read Read
Consumables Read Read




List of the Setting Items

« Printer: Print Jobs

Menu User mode Administrator mode
Print Job List Read/Modify Read /Modify
< Job
e Job List
Menu User mode Administrator mode
Current/Waiting Jobs Read Read
Job History Read Read
¢ Printer
Menu User mode Administrator mode
Job History Read Read
Error Log Read Read
¢ Fax History
Menu User mode Administrator mode
Transmission Read Read
Reception Read Read
LAN-Fax Read Read
% Address Book
Menu User mode Administrator mode
Address Book None Read/Modify
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« Configuration
* Device Settings

Menu User mode Administrator mode
System Read Read /Modify
Paper Read Read /Modify
Date/Time Read Read /Modify
Timer Read Read /Modify
Logs None Read /Modify
E-mail Read Read /Modify
Auto E-mail Notification None Read /Modify
On-demand E-mail Notifi- | None Read /Modify
cation
File Transfer None Read /Modify
User Authentication Man- | None Read /Modify
agement
Administrator Authentica- | None Read /Modify
tion Management
Program/Change Adminis- | None Read /Modify
trator
LDAP Server None Read/Modify

® Printer

Menu User mode Administrator mode
Basic Settings Read Read /Modify
Tray Parameters (PCL) None Read /Modify
Tray Parameters (PS) None Read /Modify
PDF Temporary Password | Modify None
PDF Group Password None Modify
PDF Fixed Password None Modify

e Fax

Menu User mode Administrator mode
General None Read /Modify
Administrator Tools None Read /Modify
E-mail Settings None Read /Modify
IP-Fax Settings None Read /Modify
IP-Fax Gateway Settings None Read /Modify
Parameter Settings None Read /Modify




List of the Setting Items

e Interface

Menu User mode Administrator mode
Interface Settings Read Read /Modify
¢ Network
Menu User mode Administrator mode
IPv4 Read Read/Modify
IPv6 Read Read/Modify
NetWare Read Read /Modify
AppleTalk Read Read /Modify
SMB Read Read /Modify
SNMP None Read /Modify
SNMPv3 None Read /Modify
SSDP None Read /Modify
Bonjour Read Read /Modify
System Log Read Read
* Security
Menu User mode Administrator mode
Network Security None Read /Modify
Access Control None Read /Modify
IPP Authentication None Read /Modify
SSL/TLS None Read /Modify
ssh None Read/Modify
Site Certificate None Read /Modify
Device Certificate None Read /Modify
¢ RC Gate
Menu User mode Administrator mode
Setup RC Gate None Read /Modify
Update RC Gate Firmware | None Read/Modify
RC Gate Proxy Server None Read /Modify
* Webpage
Menu User mode Administrator mode
Webpage Read /Modify Read /Modify
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¢ Extended Feature Settings

Menu User mode Administrator mode

Startup Setting None Read /Modify
Extended Feature Info None Read

Install None Read /Modify
Uninstall None Read /Modify
Administrator Tools None Read/Modify
Copy Extended Features None Read /Modify
Copy Card Save Data None Read /Modify

& Note
O Some items are not displayed depending on the security settings.




List of the Setting Items

telnet

The following telnet can be used with the machine:

access, appletalk, authfree, autonet, bonjour (rendezvous), btconfig, device-
name, dhcp, diprint, dns, domainname, help, hostname, ifconfig, info, ipp, ipv6,
lpr, netware, passwd, prnlog, route, set, show, slp, smb, snmp, sntp, spoolsw,
sprint, ssdp, ssh, status, syslog, upnp, web, wiconfig, wins

Settings that can be used with PostScript 3

The following PostScript 3 settings can be used with the machine:

@ Note

O Depending on a type of printer drivers, different items may be displayed.

Settings Selectable Items
Color/ Black and White: Color, Black and White
Color Profile: Auto, Photographic, Presentation, Solid Color, User Setting
Color Setting: Off, Fine, Super Fine
Collate: Off, On
Dithering: Auto, Photographic, Text, User Setting
Duplex: Off, Open to Left, Open to Top
Fit to Print Size: Prompt User, Nearest Size and Scale, Nearest Size and Crop
Gray Reproduction Black/Gray by K, Black by K, CMY +K, Black/Gray by K (Text
(Text/Line Art): only), Black by K (Text only)

Image Smoothing;:

Off, On, Auto, Less than 90 ppi, Less than 150 ppi, Less than
200 ppi, Less than 300 ppi

Input Tray:

AutoSelect Tray, Bypass Tray, One Sheet Bypass Tray, Tray 1,
Tray 2, Tray 3

Level Color

Off, On

Output Tray: Printer Default, Internal Tray 1

Resolution 300 dpi, 600 dpi

Separate into CMYK: Do not Separate, Cyan, Magenta, Yellow, Black, Magenta and
Yellow, Cyan and Yellow, Cyan and Magenta, Cyan and Black,
Magenta and Black, Yellow and Black

Size: See General Settings Guide.

Type: See General Settings Guide.
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Specifications

This section contains the machine's electrical and hardware specifications, in-
cluding information about its options.

Component Specifications
Resolution 600 x 600 dpi
300 x 300 dpi
Printing speed e Color:
6 ppm
e B&W:
15 ppm

(A4[), 8'/2 x 11 [J plain paper)
Printing speeds depend on the machine. Check which type of ma-
chine you have. See About This Machine.

Interface Standard:

¢ Ethernet interface (100BASE-TX / 10BASE-T)
e USB 2.0 interface

Option:
o IEEE 1284 parallel interface

Use a standard 36-pin printer cable not longer than 3 meters (10
feet).

¢ IEEE 1394 interface
e IEEE 802.11b wireless LAN interface
e Bluetooth interface
e USB Host interface

Network protocol TCP/IP, IPX/SPX, AppleTalk
Printer language Standard: PCL 6/5c, RPCS

Option: PostScript 3, PDF, PictBridge
Fonts PCL 6/5c:

Monotype Imaging 35 Intellifonts, 10 TrueType fonts, 13 Interna-
tional fonts, and 1 Bitmap font.

PostScript 3 :
136 fonts (Type 2:24, Type 14:112)

Memory 384 MB (supports up to 640 MB)

Hard disk Storage capacity : 40 GB (Optional)

Network cable 100BASE-TX / 10BASE-T shielded twisted-pair (STP, Catego-
ry/Type5) cable.
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Component

Specifications

USB Interface (Standard)

Supported Operating System:
Windows Me / 2000 / XP, Windows Server 2003, MacOS 9.2.2,
MacOS 10.3.3 or later

Transmission spec.
USB 2.0 Standard

Connectable Device:
Devices corresponding to USB 2.0 Standard

4 Note

O When using MacOS, use only the standard USB interface. The optional USB
interface board is not supported.

O When using the USB Interface (Standard) with MacOS 9.2.2, only USB 1.1 is

supported.

O When using the USB Interface (Standard) with Windows Me, install USB
Printing Support. Windows Me only supports USB 1.1 speed.



Specifications

Options

iﬁklmportant

O The optional IEEE 1394 interface board, the IEEE 802.11b interface unit, the
IEEE 1284 interface board, and Bluetooth interface unit cannot be installed
concurrently.

IEEE 1394 Interface Board Type B

% Transmission spec.:
IEEE 1394

«» Interface:
IEEE std 1394-1995 compliant
IEEE std 1394a-2000 compliant

 Device class:
SCSI print (Windows 2000 / XP, Windows Server 2003)
IPv4 over 1394 (Windows Me / XP, Windows Server 2003)

<+ Protocol:
SBP-2 (SCSI print)
TCP/IP (IPv4 over 1394)

+ Interface connector:
IEEE 1394 (6 pin x 2)

% Required cable:
1394 interface cable (6 pin x 4 pin, 6 pin x 6 pin)

& Note
O You cannot plug devices together to create loops.

O Do not use cable that is more than 4.5 meters in length.

+ Data transfer speed:
Maximum 400 Mbps

«» Connectable number of devices on a bus:
Maximum 63

< Allowed cable hops on a bus:
Maximum 16

 Power supply:
Non external power supply
Cable Power repeated (IEEE 1394a-2000 compliant)
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IEEE 1284 Interface Board Type A

% Transmission spec.:
IEEE 1284

« Required cable:
Standard IEEE 1284 compliant Micro Centronics 36 pin cable

IEEE 802.11b Interface Unit Type H

% Transmission spec.:
Based on IEEE 802.11b (wireless LAN)

« Protocol:
TCP/IP, IPX/SPX, AppleTalk

& Note
O SmartDeviceMonitor and Web Image Monitor are supported.

+ Data transfer speed:

Auto select from below speed
1 Mbps, 2 Mbps, 5.5 Mbps, 11 Mbps

« Frequency range:
¢ Inch version:
2412 - 2462 MHz (1 - 11 channels)

e Metric version:
2412 - 2472 MHz (1 - 13 channels)

«» Transmittable distance:
1 Mbps 400 m
2 Mbps 270 m
5.5 Mbps 200 m
11 Mbps 140 m

& Note

O These figures are a guideline for outdoor use. In general, the transmittable
distance indoors is 10 - 100 m, depending on environment.

% Transmission mode:
Ad hoc, and infrastructure mode
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Bluetooth Interface Unit Type 3245

% Supported Profiles:
e SPP (Serial Port Profile)
e HCRP (Hardcopy Cable Replacement Profile)
* BIP (Basic Imaging Profile)

% Frequency Range:
2.45 GHz ISM band

% Data Transmission Speed:
723 kbps

& Note

O The transmission speed is adjusted according to factors such as the dis-
tance and obstacles between the devices, radio signal condition and Blue-
tooth adaptor.

% Maximum Range:
10m

USB Host Interface Unit Type A

+ Interface Connector:
USB 1.1 host interface A type

% Data Transmission Speed:
12 Mbps (Full speed)

« Distance Between Devices:
25 m
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Envelope
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Error log, 116
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Font Manager 2000, 62
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setting, 16
setting the paper size, 19
Operating system, 143
Options, 145
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PageMaker, 63 Thick Paper
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PictBridge, 121 U
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Exiting PictBridge, 132
Form Printing, 131
Image Print Size, 128
Index Printing, 125
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Paper Size, 127

Paper type specification, 131
PictBridge Printing, 122
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Printer Features Menu, 4
Printer language, 143
Printing a PDF file directly
PDF direct print, 81
Printing Method
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Printing speed, 143
Printing with Bluetooth Connection
Windows, 56
Printing with Parallel Connection
Windows 2000, 50
Print Job List, 90
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Resolution, 143
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Sample print
deleting, 96
printing, 94

Specifications, 143

Spool printing, 117

Stored print
deleting, 107
printing, 105

Unauthorized copy control, 85
data security for copying, 86
mask type, 88

USB Host Interface Unit Type A, 147

Using commands, 84

w

Windows

canceling a job, 114
Windows 2000

printer properties, PCL, 67

printer properties, RPCS, 75
Windows 95/98/Me

printer properties, PCL, 65

printer properties, RPCS, 73
Windows NT 4.0

document defaults, PCL, 71

document defaults, RPCS, 79

printer properties, PCL, 71

printer properties, RPCS, 79
Windows Server 2003

printer properties, PCL, 69

printer properties, RPCS, 77
Windows XP

printer properties, PCL, 69

printer properties, RPCS, 77
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Note to users in the United States of America

Note:

This equipment has been tested and found to comply with the limits for a Class B digital device, pursu-
ant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against
harmful interference in a residential installation. This equipment generates, uses and can radiate radio
frequency energy and, if not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or television re-
ception, which can be determined by turning the equipment off and on, the user is encouraged to try to
correct the interference by one more of the following measures:

Reorient or relocate the receiving antenna.
Increase the separation between the equipment and receiver.

Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

Consult the dealer or an experienced radio /TV technician for help.

Caution:

Changes or modifications not expressly approved by the party responsible for compliance could void
the user's authority to operate the equipment.

Declaration of Conformity

Product Name: Printer/Scanner Controller + Copy Machine
Model Number: SGC 1506/GS 106/LD215c/Aficio 615C
Responsible party: Ricoh Corporation

Address: 5 Dedrick Place, West Caldwell, NJ 07006
Telephone number: 973-882-2000

This device complies with Part 15 of the FCC Rules.
Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and
2. this device must accept any interference received,
including interference that may cause undesired operation.

1. Properly shielded and grounded cables and connectors must be used for connections to a host
computer (and/or peripheral) in order to meet FCC emission limits.

2. An AC adapter with a ferrite core must be used for RF interference suppression.

Note to users in Canada

Note:
This Class B digital apparatus complies with Canadian ICES-003.

Remarque concernant les utilisateurs au Canada

Avertissement:
Cet appareil numérique de la classe B est conforme a la norme NMB-003 du Canada.

Copyright © 2005
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